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Welcome

Gambit is a library of game theory software and tools for the
construction and analysis of finite extensive and strategic games.
Gambit is fully-cross platform, and is supported on Linux, Mac OS X,
and Microsoft Windows.

Key features of Gambit include:


	A graphical user interface, which uses
wxWidgets [http://www.wxwidgets.org] to provide a common
interface with native look-and-feel across platforms.


	All equilibrium-computing algorithms are available as
command-line tools, callable from scripts and
other programs.


	A Python API for developing scripting applications.





Using and citing Gambit

Gambit is Free/Open Source software, released under the terms of the
GNU General Public License [http://www.gnu.org/copyleft/gpl.html‎],
Version 2.

We hope you will find Gambit useful for both teaching and research
applications. If you do use Gambit in a class, or in a paper, we would
like to hear about it. We are especially interested in finding out
what you like about Gambit, and where you think improvements could be
made.

If you are citing Gambit in a paper, we suggest a citation of the form:


McKelvey, Richard D., McLennan, Andrew M., and
Turocy, Theodore L. [http://www.gambit-project.org/turocy]
(2014).
Gambit: Software Tools for Game Theory, Version 16.0.2.
http://www.gambit-project.org.




Replace the version number and year as appropriate if you use a
different release.
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An overview of Gambit


What is Gambit?

Gambit is a set of software tools for doing computation on finite,
noncooperative games. These comprise a graphical interface for
interactively building and analyzing general games in extensive or
strategy form; a number of command-line tools for computing Nash
equilibria and other solution concepts in games; and, a set of file
formats for storing and communicating games to external tools.



A brief history of Gambit

The Gambit Project was founded in the mid-1980s by Richard McKelvey at
the California Institute of Technology. The original implementation
was written in BASIC, with a simple graphical interface. This code was
ported to C around 1990 with the help of Bruce Bell, and was
distributed publicly as version 0.13 in 1991 and 1992.

A major step in the evolution of Gambit took place with the awarding
of the NSF grants in 1994, with McKelvey and Andrew McLennan as
principal investigators, and Theodore Turocy [http://www.gambit-project.org/turocy] as the head programmer.
The grants sponsored a complete rewrite of Gambit in C++. The
graphical interface was made portable across platforms through the use
of the wxWidgets library (http://www.wxwidgets.org). Version 0.94 of Gambit was released in
the late summer of 1994, version 0.96 followed in 1999, and version
0.97 in 2002. During this time, many students at Caltech and Minnesota
contributed to the effort by programming, testing, and/or documenting.
These include, alphabetically, Bruce Bell, Anand Chelian, Matthew
Derer, Nelson Escobar, Ben Freeman, Eugene Grayver, Todd Kaplan, Geoff
Matters, Brian Trotter, Michael Vanier, Roberto Weber, and Gary Wu.

Over the same period, Bernhard von Stengel, of the London School of
Economics, made significant contributions in the implementation of the
sequence form methods for two-player extensive games, and for
contributing his “clique” code for identification of equilibrium
components in two-player strategic games, as well as other advice
regarding Gambit’s implementation and architecture.

Development since the mid-2000s has focused on two objectives. First,
the graphical interface was reimplemented and modernized, with the
goal of following good interaction design principles, especially in
regards to easing the learning curve for users new to Gambit and new
to game theory.  Second, the internal architecture of Gambit was
refactored to increase interoperability between the tools provided by
Gambit and those written independently.

Gambit is proud to have participated in the Google Summer of Code
program in the summers of 2011 and 2012 as a mentoring organization.
The Python API, which became part of Gambit from Gambit 13, was
developed during these summers, thanks in particular to the work
of Stephen Kunath and Alessandro Andrioni.



Key features of Gambit

Gambit has a number of features useful both for the researcher and the
instructor:

Interactive, cross-platform graphical interface. All Gambit
features are available through the use of a graphical interface, which
runs under multiple operating systems: Windows, various flavors of
Un*x (including Linux), and Mac OS X. The interface offers flexible
methods for creating extensive and strategic games. It offers an
interface for running algorithms to compute Nash equilibria, and for
visualizing the resulting profiles on the game tree or table, as well
as an interactive tool for analyzing the dominance structure of
actions or strategies in the game. The interface is useful for the
advanced researcher, but is intended to be accessible for students
taking a first course in game theory as well.

Command-line tools for computing equilibria. More advanced
applications often require extensive computing time and/or the ability
to script computations. All algorithms in Gambit are packaged as
individual, command-line programs, whose operation and output are
configurable.

Extensibility and interoperability. The Gambit tools read and
write file formats which are textual and documented, making them
portable across systems and able to interact with external tools. It
is therefore straightforward to extend the capabilities of Gambit by,
for example, implementing a new method for computing equilibria,
reimplementing an existing one more efficiently, or creating tools to
programmatically create, manipulate, and transform games, or for
econometric analysis on games.



Limitations of Gambit

Gambit has a few limitations that may be important in some
applications. We outline them here.

Gambit is for finite games only. Because of the mathematical
structure of finite games, it is possible to write many general-
purpose routines for analyzing these games. Thus, Gambit can be used
in a wide variety of applications of game theory. However, games that
are not finite, that is, games in which players may choose from a
continuum of actions, or in which players may have a continuum of
types, do not admit the same general-purpose methods.

Gambit is for noncooperative game theory only. Gambit focuses on
the branch of game theory in which the rules of the game are written
down explicitly, and in which players choose their actions
independently. Gambit’s analytical tools center primarily around Nash
equilibrium, and related concepts of bounded rationality such as
quantal response equilibrium. Gambit does not at this time provide any
representations of, or methods for, analyzing games written in
cooperative form. (It should be noted that some problems in
cooperative game theory do not suffer from the computational
complexity that the Nash equilibrium problem does, and thus
cooperative concepts could be an interesting future direction of
development.)

Analyzing large games may become infeasible surprisingly quickly.
While the specific formal complexity classes of computing Nash
equilibria and related concepts are still an area of active research,
it is clear that, in the typical case, the amount of time required to
compute equilibria increases rapidly in the size of the game. In other
words, it is quite easy to write down games which will take Gambit an
unacceptably long amount time to compute the equilibria of. There are
two ways to deal with this problem in practice. One way is to better
identify good heuristic approaches for guiding the equilibrium
computation process. Another way is to take advantage of known
features of the game to guide the process. Both of these approaches
are now becoming areas of active interest. While it will certainly not
be possible to analyze every game that one would like to, it is hoped
that Gambit will both contribute to these two areas of research, as
well as make the resulting methods available to both students and
practitioners.



Developers

The principal developers of Gambit are:


	Theodore Turocy [http://www.gambit-project.org/turocy],
University of East Anglia: director.


	Richard D. McKelvey, California Institute of Technology:
project founder.


	Andrew McLennan, University of Queensland: co-PI during main
development, developer and maintainer of polynomial-based algorithms
for equilibrium computation.




Much of the development of the main Gambit codebase took place in
1994-1996, under a grant from the National Science Foundation to the
California Institute of Technology and the University of Minnesota
(McKelvey and McLennan, principal investigators).

Others contributing to the development and distribution of Gambit
include:


	Bernhard von Stengel provided advice on implementation of
sequence form code, and contributed clique code


	Eugene Grayver developed the first version of the
graphical user interface.


	Gary Wu implemented an early scripting language interface for
Gambit (since superseded by the Python API).


	Stephen Kunath and Alessandro Andrioni did extensive work to create
the first release of the Python API.


	From Gambit 14, Gambit contains support for Action Graph Games
[Jiang11].  This has been contributed by Navin Bhat, Albert Jiang,
Kevin Leyton-Brown, and David Thompson, with funding support
provided by a University Graduate Fellowship of the University
of British Columbia, the NSERC Canada Graduate Scholarship, and a
Google Research Award to Leyton-Brown.






Downloading Gambit

Gambit operates on an annual release cycle roughly mirroring the
(northern hemisphere) academic year.  A new version is promoted to
stable/teaching each August; the major version number is equal to the
last two digits of the year in which the version becomes stable.

This document covers Gambit 16.0.2.
You can download it from
Sourceforge [http://sourceforge.net/projects/gambit/files/gambit16/16.0.1].
Full source code is available, as are precompiled binaries for
Microsoft Windows and Mac OS X.

Older versions of Gambit can be downloaded from
http://sourceforge.net/projects/gambit/files.  Support for older
versions is limited.



Community

The following mailing lists are available for those interested in the
use and further development of Gambit:


	gambit-announce@lists.sourceforge.net [http://lists.sourceforge.net/lists/listinfo/gambit-announce]

	Announcement-only mailing list for notifications of new releases of
Gambit.



	gambit-users@lists.sourceforge.net [http://lists.sourceforge.net/lists/listinfo/gambit-users]

	General discussion forum for teaching and research users of Gambit.



	gambit-devel@lists.sourceforge.net [http://lists.sourceforge.net/lists/listinfo/gambit-devel]

	Discussion for those interested in devleoping or extending Gambit,
or using Gambit source code in other applications.







Bug reports

In the first instance, bug reports or feature requests should be
posted to the Gambit issue tracker, located at
http://github.com/gambitproject/gambit/issues.

When reporting a bug, please be sure to include the following:


	The version(s) of Gambit you are using.  (If possible, it is helpful
to know whether a bug exists in both the current stable/teaching and
the current development/research versions.)


	The operating system(s) on which you encountered the bug.


	A detailed list of steps to reproduce the bug.  Be sure to include a
sample game file or files if appropriate; it is often helpful to
simplify the game if possible.
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The graphical interface

Gambit’s graphical user interface provides an
“integrated development environment” to help visually construct
games and to investigate their main strategic features.

The graphical interface is largely intended for the interactive
construction and analysis of small to medium games. Repeating the
caution from the introduction of this manual, the computation time
required for the equilibrium analysis of games increases rapidly in
the size of the game. The graphical interface is ideal for students
learning about the fundamentals of game theory, or for practitioners
prototyping games of interest.

In graduating to larger applications,
users are encouraged to make use of the underlying Gambit libraries
and programs directly.  For greater control over computing Nash and
quantal response equilibria of a game, see the section on
the command-line tools.
To build larger games or to explore parameter spaces of a game
systematically, it is recommended to use
the Python API.


General concepts


General layout of the main window

[image: the default extensive game at launch]
The frame presenting a game consists of two principal panels. The main
panel, to the right, displays the game graphically; in this case,
showing the game tree of a simple one-card poker game. To the left is
the player panel, which lists the players in the game; here, Fred and
Alice are the players. Note that where applicable, information is
color-coded to match the colors assigned to the players: Fred’s moves
and payoffs are all presented in red, and Alice’s in blue. The color
assigned to a player can be changed by clicking on the color icon
located to the left of the player’s name on the player panel. Player
names are edited by clicking on the player’s name, and editing the
name in the text control that appears.

Two additional panels are available. Selecting
Tools ‣ Dominance toggles
the display of an additional toolbar across the top of the window.
This toolbar controls the indication and elimination of actions or
strategies that are dominated. The use of this toolbar is discussed in
Investigating dominated strategies and actions.

Selecting View ‣ Profiles,
or clicking the show profiles icon on the
toolbar, toggles the display of the list of computed strategy profiles
on the game. More on the way the interface handles the computation of
Nash equilibria and other kinds of strategy profiles is presented
in Computing Nash equilibria.



Payoffs and probabilities in Gambit

Gambit stores all payoffs in games in an arbitrary-precision format.
Payoffs may be entered as decimal numbers with arbitrarily many
decimal places. In addition, Gambit supports representing payoffs
using rational numbers. So, for example, in any place in which a
payoff may appear, either an outcome of an extensive game or a payoff
entry in a strategic game, the payoff one-tenth may be entered either
as .1 or 1/10.

The advantage of this format is that, in certain circumstances, Gambit
may be able to compute equilibria exactly. In addition, some methods
for computing equilibria construct good numerical approximations to
equilibrium points. For these methods, the computed equilibria are
stored in floating-point format. To increase the number of decimal
places shown for these profiles, click the increase decimals icon . To
decrease the number of decimal places shown, click the decrease
decimals icon .

Increasing or decreasing the number of decimals displayed in
computed strategy profiles will not have any effect on the display of
outcome payoffs in the game itself, since those are stored in
arbitrary precision.



A word about file formats

The graphical interface manipulates several different file formats for
representing games. This section gives a quick overview of those
formats.

Gambit has for many years supported two file formats for representing
games, one for extensive games (typically using the filename extension
.efg) and one for strategic games (typically using the filename
extension .nfg). These file formats are recognized by all Gambit
versions dating back to release 0.94 in 1995. (Users interested in the
details of these file formats can consult Game representation formats
for more information.)

Beginning with release 2005.12.xx, the graphical interface now reads
and writes a new file format, which is referred to as a”Gambit
workbook.” This extended file format stores not only the
representation of the game, but also additional information, including
parameters for laying out the game tree, the colors assigned to
players, any equilibria or other analysis done on the game, and so
forth. So, for example, the workbook file can be used to store the
analysis of a game and then return to it. These files by convention
end in the extension .gbt.

The graphical interface will read files in all three formats: .gbt,
.efg, and .nfg. The “Save” and “Save as” commands, however, always
save in the Gambit workbook (.gbt) format. To save the game itself as
an extensive (.efg) or strategic (.nfg) game, use the items on the
“Export” submenu of the “File” menu. This is useful in interfacing
with older versions of Gambit, with other tools which read and write
those formats, and in using the underlying Gambit analysis command-
line tools directly, as those programs accept .efg or .nfg game files.
Users primarily interested in using Gambit solely via the graphical
interface are encouraged to use the workbook (.gbt) format.

As it is a new format, the Gambit workbook format is still under
development and may change in details. It is intended that newer
versions of the graphical interface will still be able to read
workbook files written in older formats.




Extensive games

The graphical interface provides a flexible set of operations for
constructing and editing general extensive games. These are outlined
below.


Creating a new extensive game

To create a new extensive game, select
File ‣ New ‣ Extensive game, or
click on the new extensive game icon . The extensive game created is a
trivial game with two players, named by default
Player 1 and Player 2,
with one node, which is both the root and terminal node of the game.
In addition, extensive games have a special player labeled
Chance,
which is used to represent random events not controlled by any of the
strategic players in the game.



Adding moves

There are two options for adding moves to a tree: drag-and-drop
and the Insert move dialog.


	Moves can be added to the
tree using a drag-and-drop idiom. From the player list window, drag
the player icon located to the left of the player who will have the
move to any terminal node in the game tree. The tree will be extended
with a new move for that player, with two actions at the new move.
Adding a move for the chance player is done the same way, except the
dice icon appearing to the left of the chance player in the player
list window is used instead of the player icon. For the chance player,
the two actions created will each be given a probability weight of
one-half. If the desired move has more than two actions, additional
actions can be added by dragging the same player’s icon to the move
node; this will add one action to the move each time this is done.




[image: insert move dialog]

	Click on any terminal node in
the tree, and select Edit ‣ Insert move
to display the insert move dialog.
The dialog is intended to read like a sentence:


	The first control specifies the player who will make the move. The
move can be assigned to a new player by specifying
Insert move for a new player here.


	The second control selects the information set to which to add the
move. To create the move in a new information set, select
at a new information set for this control.


	The third control sets the number of actions. This control is
disabled unless the second control is set to
at a new information set.
Otherwise, it is set automatically to the number of actions at
the selected information set.








The two methods can be useful in different contexts.
The drag-and-drop approach
is a bit quicker to use, especially when creating trees that have few
actions at each move. The dialog approach is a bit more flexible, in
that a move can be added for a new, as-yet-undefined player, a move
can be added directly into an existing information set, and a move can
be immediately given more than two actions.



Copying and moving subtrees

Many extensive games have structures that appear in multiple parts of
the tree. It is often efficient to create the structure once, and then
copy it as needed elsewhere.

Gambit provides a convenient idiom for this. Clicking on any
nonterminal node and dragging to any terminal node implements a move
operation, which moves the entire subtree rooted at the original,
nonterminal node to the terminal node.

To turn the operation into a copy operation:


	On Windows and Linux systems, hold down the Ctrl key during
the operation.


	On OS X, hold down the Cmd key when starting the
drag operation, then release prior to dropping.




The entire subtree rooted at the original node is copied,
starting at the terminal node. In this copy operation, each node in
the copied image is placed in the same information set as the
corresponding node in the original subtree.

Copying a subtree to a terminal node in that subtree is also
supported. In this case, the copying operation is halted when reaching
the terminal node, to avoid an infinite loop. Thus, this feature
can also be helpful in constructing multiple-stage games.



Removing parts of a game tree

Two deletion operations are supported on extensive games. To delete
the entire subtree rooted at a node, click on that node and select
Edit ‣ Delete subtree.

To delete an individual move from the game, click on one of the direct
children of that node, and select
Edit ‣ Delete parent. This operation
deletes the parent node, as well as all the children of the parent
other than the selected node. The selected child node now takes the
place of the parent node in the tree.



Managing information sets

Gambit provides several methods to help manage the information
structure in an extensive game.

When building a tree, new moves can be placed in a given information
set using the Insert move dialog.
Additionally, new moves can be
created using the drag-and-drop idiom by holding down the Shift
key and dragging a node in the tree. During the drag operation, the
cursor changes to the move icon . Dropping the move icon on another
node places the target node in the same information set as the node
where the drag operation began.

[image: node properties dialog]
The information set to which a node belongs can also be set by
selecting Edit ‣ Node.  This displays the
node properties dialog.
The Information set dropdown defaults
to the current information set to which the node belongs, and contains
a list of all other information sets in the game which are compatible
with the node, that is, which have the same number of
actions. Additionally, the node can be moved to a new, singleton
information set by setting this dropdown to the New
information set entry.

When building out a game tree using the drag-and-drop approach to copying portions of the tree,
the nodes created in
the copy of the subtree remain in the same information set as the
corresponding nodes in the original subtree. In many cases, though,
these trees differ in the information available to some or all of the
players. To help speed the process of adjusting information sets in
bulk, Gambit offers a “reveal” operation, which breaks information
sets based on the action taken at a particular node. Click on a node
at which the action taken is to be made known subsequently to other
players, and select Edit ‣ Reveal.  This displays a
dialog listing the players in the game. Check the boxes next to the
players who observe the outcome of the move at the node, and click
OK.  The information sets at nodes below the selected one
are adjusted based on the action selected at this node.

This is an operation that is easier to see than the explain. See the
poker tutorial
(flash version [http://www.gambit-project.org/doc/tutorials/poker.swf];
PDF version [http://www.gambit-project.org/doc/tutorials/poker.pdf])
for an application of the
revelation operation in conjunction with the tree-copy operation.


Note

The reveal operation only has an effect at the time it is done. In
particular, it does not enforce the separation of information sets
based on this information during subsequent editing of the game.
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Command-line tools

Gambit provides command-line interfaces for each method for computing
Nash equilibria.  These are suitable for scripting or calling from
other programs.  This chapter describes the use of these programs.
For a general overview of methods for computing equilibria,
see the survey of [McKMcL96].

The graphical interface also provides a frontend for calling these
programs and evaluating their output.  Direct use of the command-line
programs is intended for advanced users and applications.

These programs take an extensive or strategic game file, which can be
specified on the command line or piped via standard input, and output
a list of equilibria computed. The default output format is to present
equilibria computed as a list of comma-separated probabilities,
preceded by the tag NE. For mixed strategy profiles, the
probabilities are sorted lexicographically by player, then by
strategy.  For behavior strategy profiles, the probabilites are sorted
by player, then information set, then action number, where the
information sets for a player are sorted by the order in which they
are encountered in a depth-first traversal of the game tree.
Many programs take an option -D, which, if specified, instead prints
a more verbose, human-friendly description of each strategy profile
computed.

Many of the programs optionally output additional information
about the operation of the algorithm.  These outputs have other,
program-specific tags, described in the individual program
documentation.


gambit-enumpure: Enumerate pure-strategy equilibria of a game

gambit-enumpure reads a game on standard input and searches for
pure-strategy Nash equilibria.


Changed in version 14.0.2: The effect of the -S switch is now purely cosmetic, determining
how the equilibria computed are represented in the
output. Previously, -S computed using the strategic game; if this
was not specified for an extensive game, the agent form equilibria
were returned.




	
-S

	Report equilibria in reduced strategic form strategies, even if the
game is an extensive game.  By default, if passed an extensive
game, the output will be in behavior strategies.  Specifying this switch
does not imply any change in operation internally, as pure-strategy
equilibria are defined in terms of reduced strategic form
strategies.






	
-D

	
New in version 14.0.2.



The default output format for computed equilibria is a
comma-separated list of strategy or action probabilities, suitable
for postprocessing by automated tools.  Specifying -D instead
causes the program to output greater detail on each equilbrium
profile computed.






	
-A

	
New in version 14.0.2.



Report agent form equilibria, that is, equilibria which consider
only deviations at one information set.  Only has an effect for
extensive games, as strategic games have only one information set
per player.






	
-P

	By default, the program computes all pure-strategy Nash
equilibria in an extensive game. This switch instructs the program to
find only pure-strategy Nash equilibria which are subgame perfect.
(This has no effect for strategic games, since there are no proper
subgames of a strategic game.)






	
-h

	Prints a help message listing the available options.






	
-q

	Suppresses printing of the banner at program launch.





Computing the pure-strategy equilibria of extensive game e02.efg, the example in Figure 2 of Selten
(International Journal of Game Theory, 1975):

$ gambit-enumpure e02.efg
Search for Nash equilibria in pure strategies
Gambit version 16.0.2, Copyright (C) 1994-2022, The Gambit Project
This is free software, distributed under the GNU GPL

NE,1,0,0,0,1,0





With the -S switch, the set of equilibria returned is the same,
except expressed in strategic game strategies rather than behavior
strategies:

$ gambit-enumpure -S e02.efg
Search for Nash equilibria in pure strategies
Gambit version 16.0.2, Copyright (C) 1994-2022, The Gambit Project
This is free software, distributed under the GNU GPL

NE,1,0,0,1,0





The -A switch considers only behavior strategy profiles where there
is no way for a player to improve his payoff by changing action at
only one information set; therefore the set of solutions is larger:

$ gambit-enumpure -A e02.efg
Search for Nash equilibria in pure strategies
Gambit version 16.0.2, Copyright (C) 1994-2022, The Gambit Project
This is free software, distributed under the GNU GPL

NE,1,0,1,0,1,0
NE,1,0,1,0,0,1
NE,1,0,0,1,1,0







gambit-enumpoly: Compute equilibria of a game using polynomial systems of equations

gambit-enumpoly reads a game on standard input and
computes Nash equilibria by solving systems of polynomial equations
and inequalities.

This program searches for all Nash equilibria in a strategic game
using a support enumeration approach. This approach computes all the
supports which could, in principle, be the support of a Nash
equilibrium, and then searches for a totally mixed equilibrium on that
support by solving a system of polynomial equalities and inequalities
formed by the Nash equilibrium conditions. The ordering of the
supports is done in such a way as to maximize use of previously
computed information, making it suited to the computation of all Nash
equilibria.

When the verbose switch -v is used, the program outputs each support
as it is considered. The supports are presented as a comma-separated
list of binary strings, where each entry represents one player. The
digit 1 represents a strategy which is present in the support, and the
digit 0 represents a strategy which is not present. Each candidate
support is printed with the label “candidate,”.

Note that the subroutine to compute a solution to the system of
polynomial equations and inequalities will fail in degenerate cases.
When the verbose switch -v is used, these supports are identified on
standard output with the label “singular,”. It is possible that there
exist equilibria, often a connected component of equilibria, on these
singular supports.


	
-d

	Express all output using decimal representations with the specified
number of digits.






	
-h

	Prints a help message listing the available options.






	
-H

	By default, the program uses an enumeration method designed to
visit as few supports as possible in searching for all equilibria.
With this switch, the program uses a heuristic search method based on
Porter, Nudelman, and Shoham [PNS04], which is designed to minimize the
time until the first equilibrium is found. This switch only has an
effect when solving strategic games.






	
-S

	By default, the program uses behavior strategies for extensive
games; this switch instructs the program to use reduced strategic game
strategies for extensive games. (This has no effect for strategic
games, since a strategic game is its own reduced strategic game.)






	
-q

	Suppresses printing of the banner at program launch.






	
-v

	Sets verbose mode. In verbose mode, supports are printed on
standard output with the label “candidate” as they are considered, and
singular supports are identified with the label “singular.” By
default, no information about supports is printed.





Computing equilbria of the extensive game e01.efg, the example in Figure 1 of Selten
(International Journal of Game Theory, 1975) sometimes called
“Selten’s horse”:

$ gambit-enumpoly e01.efg
Compute Nash equilibria by solving polynomial systems
Gambit version 16.0.2, Copyright (C) 1994-2022, The Gambit Project
Heuristic search implementation Copyright (C) 2006, Litao Wei
This is free software, distributed under the GNU GPL

NE,0.000000,1.000000,0.333333,0.666667,1.000000,0.000000
NE,1.000000,0.000000,1.000000,0.000000,0.250000,0.750000
NE,1.000000,0.000000,1.000000,0.000000,0.000000,0.000000
NE,0.000000,1.000000,0.000000,0.000000,1.000000,0.000000







gambit-enummixed: Enumerate equilibria in a two-player game

gambit-enummixed reads a two-player game on standard input and
computes Nash equilibria using extreme point enumeration.

In a two-player strategic game, the set of Nash equilibria can be expressed
as the union of convex sets.  This program generates all the extreme
points of those convex sets. (Mangasarian [Man64])
This is a superset of the points generated by the path-following
procedure of Lemke and Howson (see gambit-lcp: Compute equilibria in a two-player game via linear complementarity).  It was
shown by Shapley [Sha74] that there are equilibria not accessible via
the method in gambit-lcp: Compute equilibria in a two-player game via linear complementarity, whereas the output of
gambit-enummixed is guaranteed to return all the extreme
points.


	
-d

	By default, this program computes using exact
rational arithmetic. Since the extreme points computed by this method
are guaranteed to be rational when the payoffs in the game are
rational, this permits exact computation of the equilibrium set.
Computation using rational arithmetic is in general slow, however. For
most games, acceptable results can be obtained by computing using the
computer’s native floating-point arithmetic. Using this flag enables
computation in floating-point, and expresses all output using decimal
representations with the specified number of digits.






	
-D

	Since all Nash equilibria involve only strategies which survive
iterative elimination of strictly dominated strategies, the program
carries out the elimination automatically prior to computation.
This is recommended, since it almost always results in superior
performance.
Specifying -D skips the elimination step and performs the
enumeration on the full game.






	
-c

	The program outputs the extreme equilibria as it finds them,
prefixed by the tag NE . If this option is specified, once all extreme
equilbria are identified, the program computes the convex sets which
make up the set of equilibria. The program then additionally outputs
each convex set, prefixed by convex-N , where N indexes the set. The
set of all equilibria, then, is the union of these convex sets.






	
-h

	Prints a help message listing the available options.






	
-q

	Suppresses printing of the banner at program launch.






	
-L

	Use lrslib [http://cgm.cs.mcgill.ca/~avis/C/lrs.html] by David Avis
to carry out the enumeration process.  This is an experimental
feature that has not been widely tested.





Computing the equilibria, in mixed strategies, of e02.nfg, the reduced strategic form of the example
in Figure 2 of Selten (International Journal of Game Theory,
1975):

$ gambit-enummixed e02.nfg
Compute Nash equilibria by enumerating extreme points
Gambit version 16.0.2, Copyright (C) 1994-2022, The Gambit Project
Enumeration code based on lrslib 4.2b,
Copyright (C) 1995-2005 by David Avis (avis@cs.mcgill.ca)
This is free software, distributed under the GNU GPL

NE,1,0,0,1,0
NE,1,0,0,1/2,1/2





In fact, the game e02.nfg has a one-dimensional continuum of
equilibria.  This fact can be observed by examining the connectedness
information using the -c switch:

$ gambit-enummixed -c e02.nfg
Compute Nash equilibria by enumerating extreme points
Gambit version 16.0.2, Copyright (C) 1994-2022, The Gambit Project
Enumeration code based on lrslib 4.2b,
Copyright (C) 1995-2005 by David Avis (avis@cs.mcgill.ca)
This is free software, distributed under the GNU GPL

NE,1,0,0,1,0
NE,1,0,0,1/2,1/2
convex-1,1,0,0,1/2,1/2
convex-1,1,0,0,1,0







gambit-gnm: Compute Nash equilibria in a strategic game using a global Newton method

gambit-gnm reads a game on standard input and computes Nash
equilibria using a global Newton method approach developed by Govindan
and Wilson [GovWil03]. This program is a wrapper around the
Gametracer 0.2 [http://dags.stanford.edu/Games/gametracer.html]
implementation by Ben Blum and Christian Shelton.


	
-d

	Express all output using decimal representations
with the specified number of digits.






	
-h

	Prints a help message listing the available options.






	
-n

	Randomly generate the specified number of perturbation vectors.






	
-q

	Suppresses printing of the banner at program launch.






	
-s

	Specifies a file containing a list of starting points
for the algorithm. The format of the file is comma-separated values,
one mixed strategy profile per line, in the same format used for
output of equilibria (excluding the initial NE tag).






	
-v

	Show intermediate output of the algorithm.  If this option is
not specified, only the equilibria found are reported.





Computing an equilibrium of e02.nfg,
the reduced strategic form of the example in Figure 2 of Selten
(International Journal of Game Theory, 1975):

$ gambit-gnm e02.nfg
Compute Nash equilibria using a global Newton method
Gametracer version 0.2, Copyright (C) 2002, Ben Blum and Christian Shelton
Gambit version 16.0.2, Copyright (C) 1994-2022, The Gambit Project
This is free software, distributed under the GNU GPL

NE,1,0,2.99905e-12,0.5,0.5






Note

This is an experimental program and has not been extensively tested.
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Python interface to Gambit library

Gambit provides a Python interface for programmatic manipulation of
games.  This section documents this interface, which is under active
development.  Refer to the instructions for building the Python
interface to compile and install the Python extension.


Note

Prior to 16.0.1, the Python extension was named gambit.
It is now known as pygambit to avoid a name clash with an
unrelated (and abandoned) project on PyPI.
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Sample games


	2x2x2.nfg

	A three-player normal form game with two strategies per player.
This game has nine Nash equilibria,
which is the maximal number of regular Nash equilibria possible
for a game of this size. See
McKelvey, Richard D. and McLennan, Andrew (1997).
The maximal number of regular totally mixed Nash equilibria.
Journal of Economic Theory 72(2): 411-425. [http://dx.doi.org/10.1006/jeth.1996.2214]



	2x2x2-nau.nfg

	A three-player normal form game with two strategies per player.
This game has three pure strategy equilibria, two
equilibria which are incompletely mixed, and a continuum of
completely mixed equilibria. This game appears as an example in
Nau, Robert, Gomez Canovas, Sabrina, and Hansen, Pierre (2004).
On the geometry of Nash equilibria and correlated equilibria.
International Journal of Game Theory 32(4): 443-453. [http://dx.doi.org/10.1007/s001820300162]



	bagwell.efg

	Stackelberg leader game with imperfectly observed commitment,
from Bagwell, Kyle (1993) Commitment and observability in games.
Games and Economic Behavior 8: 271-280. [http://dx.doi.org/10.1016/S0899-8256(05)80001-6]



	bayes2a.efg

	A twice-repeated Bayesian game, with two players, each having two
types and two actions. This game also illustrates the use of payoffs
at nonterminal nodes in Gambit, which can substantially simplify the
representation of multi-stage games such as this.



	cent3.efg

	A three-stage centipede game, featuring an exogenous probability
that one player is an altruistic type, who always passes.
See, for example,
McKelvey, Richard D. and Palfrey, Thomas R. (1992) An
experimental study of the centipede game.  Econometrica 60(4):
803-836. [http://www.jstor.org/stable/2951567]



	condjury.efg

	A three-person Condorcet jury game, after the analysis of
Feddersen, Timothy and Pesendorfer, Wolfgang (1998)
Convicting the innocent: The inferiority of unanimous jury verdicts
under strategic voting. American Political Science Review 92(1):
23-35. [http://www.jstor.org/stable/2585926].



	loopback.nfg

	A game due to McKelvey which illustrates that the logit quantal
response equilibrium correspondence can have a “backward-bending”
segment on the principal branch.



	montyhal.efg

	The famous
Monty Hall problem [http://en.wikipedia.org/wiki/Monty_Hall_problem]: if Monty offers
to let you switch doors, should you?



	nim.efg

	The classic game of
Nim [http://en.wikipedia.org/wiki/Nim], which is a useful example
of the value of backward induction. This version starts with five
stones.  An interesting experimental study of this class of games is
McKinney, C. Nicholas and Van Huyck, John B. (2013) Eureka
learning: Heuristics and response time in perfect information
games. Games and Economic Behavior 79:
223-232. [http:dx.doi.org/10.1016/j.geb.2013.02.003]



	pbride.efg

	A signaling game from
Joel Watson’s Strategy textbook [http://books.wwnorton.com/books/detail.aspx?ID=4294969499],
modeling the confrontation in The Princess Bride between Humperdinck
and Roberts in the bedchamber.



	poker.efg

	A simple game of one-card poker introduced in
Myerson, Roger (1991) Game Theory: Analysis of Conflict. [http://www.hup.harvard.edu/catalog.php?isbn=9780674341166].
A bit unusually for poker, the “fold” action by a player with a
strong hand counts for a win for that player, so folding is only
weakly rather than strictly dominated in this case.



	4cards.efg

	A slightly more complex poker example, contributed by Alix Martin.



	spence.efg

	A version of Spence’s classic job-market signaling game. This version
comes from Joel Watson’s Strategy textbook [http://books.wwnorton.com/books/detail.aspx?ID=4294969499].





These games, and others, ship in the standard Gambit source
distribution in the directory contrib/games.
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For contributors: Ideas and suggestions for Gambit-related projects

Research on doing computation on finite games, and using numerical and
algorithmic methods to analyze games, are areas of quite active
research.  There are a number of opportunities for programmers of all
skill levels and backgrounds to contribute to improving and extending
Gambit.

A number of such ideas are outlined in this section.
Each project includes the required implementation environment,
and a summary of the background prerequisites
someone should have in order to take on the project successfully, in
terms of mathematics, game theory, and software engineering.

Students who are interested in applying to participate in the
Google Summer of Code program should also first read our
introductory document and application template at
http://www.gambit-project.org/application.txt.

For beginning contibutors - especially those who are interested
in potentially applying to work on Gambit projects in future
Google Summer of Code editions - there are a number of
issues in the Gambit issue tracker tagged as “easy” [https://github.com/gambitproject/gambit/issues?labels=easy&sort=created&direction=desc&state=open&page=1].
These are excellent ways to get familiar with the Gambit codebase.
Contributors who have completed one or more such easy tasks will have
a significantly greater chance of being considered for possible
GSoC work.

The Gambit source tree [http://gambit.git.sourceforge.net/git/gitweb-index.cgi] is managed
using git [http://www.git-scm.com].  It is recommended to have some
familiarity with how git works, or to be willing to learn.  (It’s not
that hard, and once you do learn it, you’ll wonder how you ever lived
without it.)

This section lists project ideas pertaining to the Gambit library
and desktop interface.  There are additional project opportunities
in the Game Theory Explorer web/cloud interface.  These are
listed separately here [http://gte.csc.liv.ac.uk/index/index.html#document-ideas].


Refactor and update game representation library

The basic library (in src/libgambit) for representing games was
written in the mid-1990s.  As such, it predates many modern C++
features (including templates, STL, exceptions, Boost, and so on).
There are a number of projects for taking existing functionality,
refactoring it into separate components, and then enhancing what
those components can do.


File formats for serializing games

Gambit supports a number of file formats for reading and writing
games.  There are traditional formats for extensive and strategic
games.  The graphical interface wraps these formats into an XML
document which can store additional metadata about the game.  The Game
Theory Explorer also defines an XML format for storing games.  And,
from Gambit 14, there is a special file format for representing
games in action graph format.

Separately, Gambit has a command-line tool for outputting games in
HTML and LaTeX formats.

This project would refactor these features into a unified framework
for reading and writing games in various formats.  It would include:


	Migrating the XML manipulation code from the graphical interface
into the basic game representation library.


	Implementing in C++ the reader/writer for Game Theory Explorer files
(a first version of this is available in Python in the gambit.gte
module).


	Unifying the gambit-nfg2tex and
gambit-nfg2html command line tools into a
gambit-convert tool, which would convert from and to many
file formats.


	Extend all the Gambit command-line tools to read files of any
accepted format, and not just .efg and .nfg files.


	Languages: C++; Python/Cython optional; XML experience helpful


	Prerequisites: Introductory game theory for familiarity with
terminology of the objects in a game; undergraduate-level software
engineering experience.






Structure equilibrium calculations using the strategy pattern

Gambit’s architecture packages methods for finding Nash equilibria as
standalone command-line tools.  Owing to different histories in
implementing these methods, internally the interfaces to these methods
at the C++ level are quite heterogeneous.  In some cases, something
like the “strategy pattern” has been used to encapsulate these
algorithms.  In others, the interface is simply a global-scope
function call with little or no structured interface.

This project would involve organizing all these interfaces in a
consistent and unified way using the “strategy pattern.”  One can see
an emerging structure in the gambit-enumpure
implementation at src/tools/enumpure/enumpure.cc in the master
branch of the git repository.  The idea would be to develop a unified
framework for being able to interchange methods to compute Nash
equilibria (or other concepts) on games.  If the project were to go
well, as an extension these interfaces could then be wrapped in the
Python API for direct access to the solvers (which are currently
called via the command-line tools).


	Languages: C++.


	Prerequisites: Introductory game theory for familiarity with
terminology of the objects in a game; undergraduate-level software
engineering experience.






Implement Strategic Restriction of a game in C++

Gambit has a concept of a StrategySupport (defined in
src/libgambit/stratspt.h and src/libgambit/stratspt.cc),
which is used, among other things, to represent a game where strictly
dominated strategies have been eliminated (which can be useful in
improving the efficiency of equilibrium computations).  The
implementation of this has historically been awkward.  Proper OO
design would suggest that a StrategySupport should be
able to be used anywhere a Game could be used, but this
is not the case.  In practice, a StrategySupport has just
been a subset of the strategies of a game, which has to be passed
along as a sidecar to the game in order to get anything done.

Recently, in the Python API, the model for dealing with this has been
improved.  In Python, there is a StrategicRestriction
of a game, which in fact can be used seamlessly anyplace a game can be
used.  Separately, there is a StrategySupportProfile,
which is basically just a subset of strategies of a game.  This
separation of concepts has proven to be clean and useful.

The project would be to develop the concept of a strategic restriction
in C++, using the Python API as a model, with the idea of ultimately
replacing the StrategySupport.


	Languages: C++; Python/Cython useful for understanding the
current implementation in Python.


	Prerequisites: Introductory game theory for familiarity with
terminology of the objects in a game; undergraduate-level software
engineering experience.






Implement Behavior Restriction of a game in Python

The Python API has a concept of a StrategicRestriction of
a game, which is the restriction of a game to a subset of strategies
for each player.  This restriction can be used seamlessly anywhere a
game can be used.

This project would develop a parallel concept of a
BehaviorRestriction.  Logically this is similar to a
StrategicRestriction, except that instead of operating on
the set of reduced strategic game strategies, it would operate on
behavior strategies (actions at information sets) in a game tree.

This is a bit more challenging than the
StrategicRestriction because of the need to be able to
traverse the resulting game tree.  Removing actions from a game can
result in entire subtrees of the game being removed, which can then
include the removal of information sets from the game so restricted.

The idea of this project is to carry out the implementation in
Python/Cython first, as the experience from the strategic restriction
project was that the more rapid prototyping possible in Python was a
big help.  However, as the ultimate goal will be to provide this at
the C++ level, there is also the possibility of attacking the problem
directly in C++ as well.


	Langauges: Python/Cython; C++.


	Prerequisites: Introductory game theory for familiarity with
terminology of the objects in a game; undergraduate-level software
engineering experience.







Implementing algorithms for finding equilibria in games

Each of the following are separate ideas for open projects on
computing equilibria and other interesting quantities on games.
Each of these is a single project  For GSoC applications, you should
select exactly one of these, as each is easily a full summer’s worth
of work (no matter how easy some of them may seem at first read!)


Enumerating all equilibria of a two-player bimatrix game using the EEE algorithm

The task is to implement the EEE algorithm, which is a published algorithm to
enumerate all extreme equilibria of a bimatrix game.


	Languages: C, Java


	Prerequisites:  Background in game theory, basic linear
algebra and linear programming.  Experience with programs of at least
medium complexity so that existing code can be expanded.




Fuller details:

The task is to implement the EEE algorithm, which is a published algorithm to
enumerate all extreme equilibria of a bimatrix game.

The most up-to-date version can be found in Sections 7 and 8
of


D. Avis, G. Rosenberg, R. Savani, and B. von Stengel (2010),
Enumeration of Nash equilibria for two-player games.
Economic Theory 42, 9-37.

http://www.maths.lse.ac.uk/Personal/stengel/ETissue/ARSvS.pdf




Extra information, including some code,
is provided in the following report:


G. Rosenberg (2004),
Enumeration of All Extreme Equilibria of Bimatrix Games with Integer Pivoting and Improved Degeneracy Check.
CDAM Research Report LSE-CDAM-2004-18.

http://www.cdam.lse.ac.uk/Reports/Files/cdam-2005-18.pdf




The original algorithm was described in the following paper:


C. Audet, P. Hansen, B. Jaumard, and G. Savard (2001),
Enumeration of all extreme equilibria of bimatrix games.
SIAM Journal on Scientific Computing 23, 323–338.




The implementation should include a feature to compare the
algorithm’s output (a list of extreme equilibria) with the
ouput of other algorithms for the same task (e.g.
lrsnash).

In addition a framework that compares running times (and the
number of recursive calls, calls to pivoting methods, and
other crucial operations) should be provided.
The output should record and document the computational
experiments so that they can be reproduced, in a general
setup - sufficiently documented - that can be used for
similar comparisons.



Improve integration and testing of Gametracer

Gambit incorporates the
Gametracer [http://dags.stanford.edu/Games/gametracer.html] package
to provide
implementations of two methods for computing equilibria,
gambit-gnm and gambit-ipa.
The integration
is rather crude, as internally the program converts the game
from native Gambit representation into Gametracer’s
representation, and the converts the output back.  Using
Gametracer’s implementations as a starting point, refactor
the implementation to use Gambit’s native classes directly,
and carry out experiments on the reliability and performance
of the algorithms.


	Languages: C++


	Prerequisites: Some level of comfort with linear algebra;
enjoyment of refactoring code.






Interface with lrslib

Gambit’s gambit-enummixed tool computes all
extreme Nash equilibria of a two-player game.  There is another
package, lrslib by David Avis [http://cgm.cs.mcgill.ca/~avis/C/lrs.html], which implements the
same algorithm more efficiently and robustly.  There is a partial
interface with an older version of lrslib in the Gambit source tree,
which has proven not to be very reliable.  The project is to complete
the integration and testing of the lrslib integration.


	Languages: C/C++


	Prerequisites: Some level of comfort with linear algebra.






Finding equilibria reachable by Lemke’s algorithm with varying “covering vectors”

Related to the Lemke-Howson method above, but with a
slightly different algorithm that has an extra parameter,
called the “covering vector”.  That parameter can serve a
randomly selected starting point of the computation and
potentially reach many more equilibria.


	Prerequisites: Theoretical understanding of the Lemke-Howson
method or of the Simplex algorithm for Linear Programming.
Literature exists that is accessible for students with at
least senior-level background in computer science,
mathematics or operations research.  An existing
implementation of a Lemke-Howson style pivoting algorithm
should be adapted with suitable alterations.






Computing the index of an equilibrium component

The task is to implement a published algorithm to compute
the so-called index of an equilibrium component in a
bimatrix game.  This component is the output to an existing
enumeration algorithm.


	Languages: C


	Prerequisites:  Senior-level mathematics, interest in game theory
and some basic topology.




Fuller details:

The aim of this project is to implement an existing
algorithm that finds the index of an equilibrium component.
The relevant description of this is chapter 2 of


Anne Balthasar, Geometry and Equilibria in Bimatrix Games,
PhD Thesis, London School of Economics, 2009.

http://www.maths.lse.ac.uk/Personal/stengel/phds/#anne





	which are pages 21-41 of

	http://www.maths.lse.ac.uk/Personal/stengel/phds/anne-final.pdf





The mathematics in this chapter are pretty scary (in
particular section 2.2, which is however not needed) but the
final page 41 which describes the algorithm is less scary.

Nevertheless, this is rather advanced material because it
builds on several different existing algorithms (for finding
extreme equilibria in bimatrix games, and “cliques” that
define convex sets of equilibria, and their non-disjoint
unions that define “components”).  It requires the
understanding of what equilibria in bimatrix games are
about.  These algorithms are described in


D. Avis, G. Rosenberg, R. Savani, and B. von Stengel (2010),
Enumeration of Nash equilibria for two-player games.
Economic Theory 42, 9-37.

http://www.maths.lse.ac.uk/Personal/stengel/ETissue/ARSvS.pdf




and students who do not eventually understand that text
should not work on this project.  For this reason, at least
senior-level (= third year) mathematics is required in terms of
mathematical maturity.  In the Avis et al. (2010) paper,
pages 19-21 describe the lexicographic method for pivoting
as it is used in the simplex method for linear programming.
A variant of this lexicographic method is used in the
chapter by Anne Balthasar.  Understanding this is a
requirement to work on this project (and a good test of how
accessible all this is).

We give here two brief examples that supplement the above
literature.  Consider the following bimatrix game.  It is
very simple, and students of game theory may find it useful
to first find out on their own what the equilibria of this
game are:

2 x 2 Payoff matrix A:

1  1
0  1

2 x 2 Payoff matrix B:

1  1
0  1

EE = Extreme Equilibrium, EP = Expected Payoff

EE  1  P1:  (1)  1  0  EP=  1  P2:  (1)  1  0  EP=  1
EE  2  P1:  (1)  1  0  EP=  1  P2:  (2)  0  1  EP=  1
EE  3  P1:  (2)  0  1  EP=  1  P2:  (2)  0  1  EP=  1

Connected component 1:
{1, 2}  x  {2}
{1}  x  {1, 2}





This shows the following:  there are 3 Nash equilibria,
which partly use the same strategies of the two players,
which are numbered (1), (2)  for each player.  It will take
a bit of time to understand the above output.  For our
purposes, the bottom “component” is most relevant:
It has two lines, and  {1, 2}  x  {2}   means
that equilibrium (1),(2)  -  which is according to the
previous list the strategy pair (1,0), (1,0)  as well as
(2),(2),   which is   (0,1), (1,0)  are “extreme
equilibria”, and moreover any convex combination of (1) and
(2) of player 1  - this is the first {1, 2} - can be
combined with strategy (2) of player 2.
This is part of the “clique” output of Algorithm 2 on page
19 of Avis et al. (2010).
There is a second such convex set of equilibria in the
second line, indicated by {1}  x  {1, 2}.
Moreover, these two convex sets intersect (in the
equilibrium  (1),(2))  and form therefore a “component” of
equilibria.  For such a component, the index has to be
found, which happens to be the integer 1 in this case.

The following bimatrix game has also two convex sets of Nash
equilibria, but they are disjoint and therefore listed as
separate components on their own:

3 x 2 Payoff matrix A:

1  1
0  1
1  0

3 x 2 Payoff matrix B:

2  1
0  1
0  1

EE = Extreme Equilibrium, EP = Expected Payoff

Rational Output

EE  1  P1:  (1)    1    0    0  EP=  1  P2:  (1)  1  0  EP= 2
EE  2  P1:  (2)  1/2  1/2    0  EP=  1  P2:  (2)  0  1  EP= 1
EE  3  P1:  (3)  1/2    0  1/2  EP=  1  P2:  (1)  1  0  EP= 1
EE  4  P1:  (4)    0    1    0  EP=  1  P2:  (2)  0  1  EP= 1

Connected component 1:
{1, 3}  x  {1}

Connected component 2:
{2, 4}  x  {2}





Here the first component has index 1 and the second has
index 0.  One reason for the latter is that if the game is
slightly perturbed, for example by giving a slightly lower
payoff than 1 in row 2 of the game, then the second strategy
of player 1 is strictly dominated and the equilibria (2) and
(4) of player 1, and thus the entire component 2, disappear
altogether.  This can only happen if the index is zero, so
the index gives some useful information as to whether an
equilibrium component is “robust” or “stable” when payoffs
are slightly perturbed.



Enumerating all equilibria of a two-player game tree

Extension of an existing algorithm for enumerating all
equilibria of a bimatrix game to game trees with imperfect
information using the so-called “sequence form”.  The method
is described in abstract form but not implemented.


	Langauges: C++


	Prerequisites: Background in game theory and basic linear
algebra.  Experience with programs of at least
medium complexity so that existing code can be expanded.






Solving for equilibria using polynomial systems of equations

The set of Nash equilibrium conditions can be expressed as a
system of polynomial equations and inequalities.  The field
of algebraic geometry has been developing packages to
compute all solutions to a system of polynomial equations.
Two such packages are
PHCpack [http://www.math.uic.edu/~jan/download.html"] and
Bertini [http://www.nd.edu/~sommese/bertini/].
Gambit has an
experimental interface, written in Python, to build the
required systems of equations, call out to the solvers, and
identify solutions corresponding to Nash equilibria.
Refactor the implementation to be more flexible and
Pythonic, and carry out experiments on the reliability and
performance of the algorithms.


	Languages: Python


	Prerequisites: Experience with text processing to pass data to
and from the external solvers.






Implement Herings-Peeters homotopy algorithm to compute Nash equilibria

Herings and Peeters
(Economic Theory, 18(1), 159-185, 2001 [http://dx.doi.org/10.1007/PL00004129]) have proposed a
homotopy algorithm to compute Nash equilibria.  They have
created a
first implementation of the method in Fortran [http://www.personeel.unimaas.nl/r.peeters/software.htm],
using hompack [http://www.netlib.org/hompack/].
Create a Gambit implementation of this method, and carry out
experiments on the reliability and performance of the
algorithms.


	Languages: C/C++, ability to at least read Fortran


	Prerequisites: Basic game theory and knowledge of pivoting
algorithms like the Simplex method for Linear Programming or
the Lemke-Howson method for games.  Senior-level
mathematics, mathematical economics, or operations research.
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For developers: Building Gambit from source

This section covers instructions for building Gambit from source.
This is for those who are interested in developing Gambit, or who
want to play around with the latest features before they make it
into a pre-compiled binary version.

This section requires at least some familiarity with programming.
Most users will want to stick with binary distributions; see
Downloading Gambit for how to get the current version for
your operating system.


General information

Gambit uses the standard autotools mechanism for configuring and building.
This should be familiar to most users of Un*ces and MacOS X.

If you are building from a source tarball,
you just need to unpack the sources, change directory to the top level
of the sources (typically of the form gambit-xx.y.z), and do the
usual

./configure
make
sudo make install





Command-line options are available to modify the configuration process;
do ./configure –help for information.  Of these, the option which
may be most useful is to disable the build of the graphical interface

By default Gambit will be installed in /usr/local.  You can change this
by replacing configure step with one of the form

./configure --prefix=/your/path/here






Note

The graphical interface relies on external calls to other
programs built in this process, especially for the computation of
equilibria.  It is strongly recommended that you install the Gambit
executables to a directory in your path!
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Game representation formats

This section documents the file formats recognized by Gambit. These
file formats are text-based and designed to be readable and editable
by hand by humans to the extent possible, although programmatic tools
to generate and manipulate these files are almost certainly needed for
all but the most trivial of games.

These formats can be viewed as being low-level. They define games
explicitly in terms of their structure, and do not support any sort of
parameterization, macros, and the like. Thus, they are adapted largely
to the type of input required by the numerical methods for computing
Nash equilibria, which only apply to a particular realization of a
game’s parameters. Higher-level tools, whether the graphical interface
or scripting applications, are indicated for doing parametric analysis
and the like.


Conventions common to all file formats

Several conventions are common to the interpretation of the file
formats listed below.

Whitespace is not significant. In general, whitespace (carriage
returns, horizontal and vertical tabs, and spaces) do not have an
effect on the meaning of the file. The only exception is inside
explicit double-quotes, where all characters are significant. The
formatting shown here is the same as generated by the Gambit code and
has been chosen for its readability; other formattings are possible
(and legal).

Text labels. Most objects in an extensive game may be given
textual labels. These are prominently used in the graphical interface,
for example, and it is encouraged for users to assign nonempty text
labels to objects if the game is going to be viewed in the graphical
interface. In all cases, these labels are surrounded by the quotation
character (“). The use of an explicit ” character within a text label
can be accomplished by preceding the embedded ” characters with a
backwards slash ().
Example 5-1. Escaping quotes in a text label

This is an alternate version of the first line of the example file, in
which the title of the game contains the term Bayesian game in
quotation marks.

EFG 2 R "An example of a \"Bayesian game\"" { "Player 1" "Player 2" }





Numerical data. yNumerical data, namely, the payoffs at outcomes,
and the action probabilities for chance nodes, may be expressed in
integer, decimal, or rational formats. In all cases, numbers are
understood by Gambit to be exact, and represented as such internally.
For example, the numerical entries 0.1 and 1/10 represent the same
quantity.

In versions 0.97 and prior, Gambit distinguished between floating
point and rational data. In these versions, the quantity 0.1 was
represented interally as a floating-point number. In this case, since
0.1 does not have an exact representation in binary floating point,
the values 0.1 and 1/10 were not identical, and some methods for
computing equilibria could give (slightly) different results for games
using one versus the other. In particular, using rational-precision
methods on games with the floating point numbers could give unexpected
output, since the conversion of 0.1 first to floating-point then to
rational would involve roundoff error. This is largely of technical
concern, and the current Gambit implementation now behaves in such a
way as to give the “expected” result when decimal numbers appear in
the file format.



The extensive game (.efg) file format

The extensive game (.efg) file format has been used by Gambit, with
minor variations, to represent extensive games since circa 1994. It
replaced an earlier format, which had no particular name but which had
the conventional extension .dt1. It is intended that some new formats
will be introduced in the future; however, this format will be
supported by Gambit, possibly through the use of converter programs to
those putative future formats, for the foreseeable future.


A sample file

This is a sample file illustrating the general format of the file.
This file is similar to the one distributed in the Gambit distribution
under the name bayes1a.efg .

EFG 2 R "General Bayes game, one stage" { "Player 1" "Player 2" }
c "ROOT" 1 "(0,1)" { "1G" 0.500000 "1B" 0.500000 } 0
c "" 2 "(0,2)" { "2g" 0.500000 "2b" 0.500000 } 0
p "" 1 1 "(1,1)" { "H" "L" } 0
p "" 2 1 "(2,1)" { "h" "l" } 0
t "" 1 "Outcome 1" { 10.000000 2.000000 }
t "" 2 "Outcome 2" { 0.000000 10.000000 }
p "" 2 1 "(2,1)" { "h" "l" } 0
t "" 3 "Outcome 3" { 2.000000 4.000000 }
t "" 4 "Outcome 4" { 4.000000 0.000000 }
p "" 1 1 "(1,1)" { "H" "L" } 0
p "" 2 2 "(2,2)" { "h" "l" } 0
t "" 5 "Outcome 5" { 10.000000 2.000000 }
t "" 6 "Outcome 6" { 0.000000 10.000000 }
p "" 2 2 "(2,2)" { "h" "l" } 0
t "" 7 "Outcome 7" { 2.000000 4.000000 }
t "" 8 "Outcome 8" { 4.000000 0.000000 }
c "" 3 "(0,3)" { "2g" 0.500000 "2b" 0.500000 } 0
p "" 1 2 "(1,2)" { "H" "L" } 0
p "" 2 1 "(2,1)" { "h" "l" } 0
t "" 9 "Outcome 9" { 4.000000 2.000000 }
t "" 10 "Outcome 10" { 2.000000 10.000000 }
p "" 2 1 "(2,1)" { "h" "l" } 0
t "" 11 "Outcome 11" { 0.000000 4.000000 }
t "" 12 "Outcome 12" { 10.000000 2.000000 }
p "" 1 2 "(1,2)" { "H" "L" } 0
p "" 2 2 "(2,2)" { "h" "l" } 0
t "" 13 "Outcome 13" { 4.000000 2.000000 }
t "" 14 "Outcome 14" { 2.000000 10.000000 }
p "" 2 2 "(2,2)" { "h" "l" } 0
t "" 15 "Outcome 15" { 0.000000 4.000000 }
t "" 16 "Outcome 16" { 10.000000 0.000000 }







Structure of the prologue

The extensive gamefile consists of two parts: the prologue, or header,
and the list of nodes, or body. In the example file, the prologue is
the first line. (Again, this is just a consequence of the formatting
we have chosen and is not a requirement of the file structure itself.)

The prologue is constructed as follows. The file begins with the token
EFG , identifying it as an extensive gamefile. Next is the digit 2 ;
this digit is a version number. Since only version 2 files have been
supported for more than a decade, all files have a 2 in this position.
Next comes the letter R . The letter R used to distinguish files which
had rational numbers for numerical data; this distinction is obsolete,
so all new files should have R in this position.

The prologue continues with the title of the game. Following the title
is a list of the names of the players defined in the game. This list
follows the convention found elsewhere in the file of being surrounded
by curly braces and delimited by whitespace (but not commas,
semicolons, or any other character). The order of the players is
significant; the first entry in the list will be numbered as player 1,
the second entry as player 2, and so forth.  At the end of the prologue
is an optional text comment field.



Structure of the body (list of nodes)

The body of the file lists the nodes which comprise the game tree.
These nodes are listed in the prefix traversal of the tree. The prefix
traversal for a subtree is defined as being the root node of the
subtree, followed by the prefix traversal of the subtree rooted by
each child, in order from first to last. Thus, for the whole tree, the
root node appears first, followed by the prefix traversals of its
child subtrees. For convenience, the game above follows the convention
of one line per node.

Each node entry begins with an unquoted character indicating the type
of the node. There are three node types:


	c for a chance node


	p for a personal player node


	t for a terminal node




Each node type will be discussed individually below. There are three
numbering conventions which are used to identify the information
structure of the tree. Wherever a player number is called for, the
integer specified corresponds to the index of the player in the player
list from the prologue. The first player in the list is numbered 1,
the second 2, and so on. Information sets are identified by an
arbitrary positive integer which is unique within the player. Gambit
generates these numbers as 1, 2, etc. as they appear first in the
file, but there are no requirements other than uniqueness. The same
integer may be used to specify information sets for different players;
this is not ambiguous since the player number appears as well.
Finally, outcomes are also arbitrarily numbered in the file format in
the same way in which information sets are, except for the special
number 0 which indicates the null outcome.

Information sets and outcomes may (and frequently will) appear
multiple times within a game. By convention, the second and subsequent
times an information set or outcome appears, the file may omit the
descriptive information for that information set or outcome.
Alternatively, the file may specify the descriptive information again;
however, it must precisely match the original declaration of the
information set or outcome. If any part of the description is omitted,
the whole description must be omitted.

Outcomes may appear at nonterminal nodes. In these cases, payoffs are
interepreted as incremental payoffs; the payoff to a player for a
given path through the tree is interpreted as the sum of the payoffs
at the outcomes encountered on that path (including at the terminal
node). This is ideal for the representation of games with well-
defined”stages”; see, for example, the file bayes2a.efg in the Gambit
distribution for a two-stage example of the Bayesian game represented
previously.

In the following lists, fields which are omittable according to the
above rules are indicated by the label (optional).

Format of chance (nature) nodes. Entries for chance nodes begin
with the character c . Following this, in order, are


	a text string, giving the name of the node


	a positive integer specifying the information set number


	(optional) the name of the information set


	(optional) a list of actions at the information set with their
corresponding probabilities


	a nonnegative integer specifying the outcome


	(optional)the payoffs to each player for the outcome




Format of personal (player) nodes. Entries for personal player
decision nodes begin with the character p . Following this, in order,
are:


	a text string, giving the name of the node


	a positive integer specifying the player who owns the node


	a positive integer specifying the information set


	(optional) the name of the information set


	(optional) a list of action names for the information set


	a nonnegative integer specifying the outcome


	(optional) the name of the outcome


	the payoffs to each player for the outcome




Format of terminal nodes. Entries for terminal nodes begin with
the character t . Following this, in order, are:


	a text string, giving the name of the node


	a nonnegative integer specifying the outcome


	(optional) the name of the outcome


	the payoffs to each player for the outcome




There is no explicit end-of-file delimiter for the file.




The strategic game (.nfg) file format, payoff version

This file format defines a strategic N-player game. In this version,
the payoffs are listed in a tabular format. See the next section for a
version of this format in which outcomes can be used to identify an
equivalence among multiple strategy profiles.


A sample file

This is a sample file illustrating the general format of the file.
This file is distributed in the Gambit distribution under the name
e02.nfg .

NFG 1 R "Selten (IJGT, 75), Figure 2, normal form"
{ "Player 1" "Player 2" } { 3 2 }

1 1 0 2 0 2 1 1 0 3 2 0







Structure of the prologue

The prologue is constructed as follows. The file begins with the token
NFG , identifying it as a strategic gamefile. Next is the digit 1 ;
this digit is a version number. Since only version 1 files have been
supported for more than a decade, all files have a 1 in this position.
Next comes the letter R . The letter R used to distinguish files which
had rational numbers for numerical data; this distinction is obsolete,
so all new files should have R in this position.

The prologue continues with the title of the game. Following the title
is a list of the names of the players defined in the game. This list
follows the convention found elsewhere in the file of being surrounded
by curly braces and delimited by whitespace (but not commas,
semicolons, or any other character). The order of the players is
significant; the first entry in the list will be numbered as player 1,
the second entry as player 2, and so forth.

Following the list of players is a list of positive integers. This
list specifies the number of strategies available to each player,
given in the same order as the players are listed in the list of
players.

The prologue concludes with an optional text comment field.



Structure of the body (list of payoffs)

The body of the format lists the payoffs in the game. This is a “flat”
list, not surrounded by braces or other punctuation.

The assignment of the numeric data in this list to the entries in the
strategic game table proceeds as follows. The list begins with the
strategy profile in which each player plays their first strategy. The
payoffs to all players in this contingency are listed in the same
order as the players are given in the prologus. This, in the example
file, the first two payoff entries are 1 1 , which means, when both
players play their first strategy, player 1 receives a payoff of 1,
and player 2 receives a payoff of 1.

Next, the strategy of the first player is incremented. Thus, player
1’s strategy is incremented to his second strategy. In this case, when
player 1 plays his second strategy and player 2 his first strategy,
the payoffs are 0 2 : a payoff of 0 to player 1 and a payoff of 2 to
player 2.

Now the strategy of the first player is again incremented. Thus, the
first player is playing his third strategy, and the second player his
first strategy; the payoffs are again 0 2 .

Now, the strategy of the first player is incremented yet again. But,
the first player was already playing strategy number 3 of 3. Thus, his
strategy now “rolls over” to 1, and the strategy of the second player
increments to 2. Then, the next entries 1 1 correspond to the payoffs
of player 1 and player 2, respectively, in the case where player 1
plays his second strategy, and player 2 his first strategy.

In general, the ordering of contingencies is done in the same way that
we count: incrementing the least-significant digit place in the number
first, and then incrementing more significant digit places in the
number as the lower ones “roll over.” The only differences are that
the counting starts with the digit 1, instead of 0, and that the
“base” used for each digit is not 10, but instead is the number of
strategies that player has in the game.




The strategic game (.nfg) file format, outcome version

This file format defines a strategic N-player game. In this version,
the payoffs are defined by means of outcomes, which may appear more
than one place in the game table. This may give a more compact means
of representing a game where many different strategy combinations map
to the same consequences for the players. For a version of this format
in which payoffs are listed explicitly, without identification by
outcomes, see the previous section.


A sample file

This is a sample file illustrating the general format of the file.
This file defines the same game as the example in the previous
section.

NFG 1 R "Selten (IJGT, 75), Figure 2, normal form" { "Player 1" "Player 2" }

{
{ "1" "2" "3" }
{ "1" "2" }
}

{
{ "" 1, 1 }
{ "" 0, 2 }
{ "" 0, 2 }
{ "" 1, 1 }
{ "" 0, 3 }
{ "" 2, 0 }
}
1 2 3 4 5 6







Structure of the prologue

The prologue is constructed as follows. The file begins with the token
NFG , identifying it as a strategic gamefile. Next is the digit 1 ;
this digit is a version number. Since only version 1 files have been
supported for more than a decade, all files have a 1 in this position.
Next comes the letter R . The letter R used to distinguish files which
had rational numbers for numerical data; this distinction is obsolete,
so all new files should have R in this position.

The prologue continues with the title of the game. Following the title
is a list of the names of the players defined in the game. This list
follows the convention found elsewhere in the file of being surrounded
by curly braces and delimited by whitespace (but not commas,
semicolons, or any other character). The order of the players is
significant; the first entry in the list will be numbered as player 1,
the second entry as player 2, and so forth.

Following the list of players is a list of strategies. This is a
nested list; each player’s strategies are given as a list of text
labels, surrounded by curly braces.

The nested strategy list is followed by an optional text comment
field.

The prologue closes with a list of outcomes. This is also a nested
list. Each outcome is specified by a text string, followed by a list
of numerical payoffs, one for each player defined. The payoffs may
optionally be separated by commas, as in the example file. The
outcomes are implicitly numbered in the order they appear; the first
outcome is given the number 1, the second 2, and so forth.



Structure of the body (list of outcomes)

The body of the file is a list of outcome indices. These are presented
in the same lexicographic order as the payoffs in the payoff file
format; please see the documentation of that format for the
description of the ordering. For each entry in the table, a
nonnegative integer is given, corresponding to the outcome number
assigned as described in the prologue section. The special outcome
number 0 is reserved for the “null” outcome, which is defined as a
payoff of zero to all players. The number of entries in this list,
then, should be the same as the product of the number of strategies
for all players in the game.




The action graph game (.agg) file format

Action graph games (AGGs) are a compact representation of simultaneous-move games with structured utility functions.
For more information on AGGs, the following paper gives a comprehensive discussion.


A.X. Jiang, K. Leyton-Brown and N. Bhat, Action-Graph Games [http://www.cs.ubc.ca/~jiang/papers/AGG.pdf], Games and Economic Behavior, Volume 71, Issue 1, January 2011, Pages 141-173.




Each file in this format describes an action graph game.
In order for the file to be recognized as AGG by GAMBIT, the initial line of the file should be:

#AGG





The rest of the file consists of 8 sections, separated by whitespaces. Lines with starting ‘#’ are treated as comments and are allowed between sections.


	The number of players, n.


	The number of action nodes, |S|.


	The number of function nodes, |P|.


	Size of action set for each player. This is a row of n integers:

|S1| |S2| …. |Sn|



	Each Player’s action set. We have N rows; row i has |Si| integers in ascending order,
which are indices of Action nodes. Action nodes are indexed from 0 to |S|-1.


	The Action Graph. We have |S|+|P| nodes, indexed from 0 to |S|+|P|-1.
The function nodes are indexed after the action nodes. The graph
is represented as (|S|+|P|) neighbor lists, one list per row.
Rows 0 to |S|-1 are for action nodes; rows |S| to |S|+|P|-1 are for
function nodes. In each row, the first number |v| specifies the
number of neighbors of the node. Then follows |v| numbers,
corresponding to the indices of the neighbors.

We require that each function node has at least one neighbor, and
the neighbors of function nodes are action nodes. The action graph
restricted to the function nodes has to be a directed acyclic graph (DAG).



	Signatures of functions.   This is |P| rows, each specifying the mapping
f_p that maps from the configuration of the function node p’s neighbors to
an integer for p’s “action count”. Each function is specified by its “signature”
consisting of an integer type, possibly followed by further parameters. Several types of mapping are
implemented:


	Types 0-3 require no further input.



	Type 0: Sum. i.e. The action count of a function node p is the sum of
the action counts  of p’s neighbors.


	Type 1: Existence: boolean for whether the sum of the counts of
neighbors are positive.


	Type 2: The index of the neighbor with the highest index that has
non-zero counts, or |S|+|P| if none applies.


	Type 3: The index of the neighbor with the lowest index that has
non-zero counts, or |S|+|P| if none applies.









	Types 10-13 are extended versions of type 0-3, each requiring
further parameters of an integer default value and a list of weights,
|S| integers enclosed in square brackets. Each action node is thus associated with an integer weight.



	Type 10: Extended Sum. Each instance of an action in p’s neighborhood being chosen contributes the
weight of that action to the sum. These are added to the default value.


	Type 11: Extended Existence: boolean for whether the extended sum is positive. The input default value
and weights are required to be nonnegative.


	Type 12: The weight of the neighbor with the highest index that has
non-zero counts, or the default value if none applies.


	Type 13: The weight of the neighbor with the lowest index that has
non-zero counts, or the default value if none applies.











The following is an example of the signatures for an AGG with three action nodes and two function nodes:

2
10 0 [2 3 4]







	The payoff function for each action node. So we have
|S| subblocks of numbers. Payoff function for action s is a mapping
from configurations to real numbers. Configurations are
represented as a tuple of integers; the size of the tuple is the size
of the neighborhood of s. Each configuration specifies the action counts
for the neighbors of s, in the same order as the neighbor list of s.

The first number of each subblock specifies
the type of the payoff function. There are multiple ways of representing
payoff functions; we (or other people) can extend the file format by
defining new types of payoff functions. We define two basic types:


	Type 0

	The complete representation. The set of possible
configurations can be derived from the action graph. This set of
configurations can also be sorted in lexicographical order. So we can
just specify the payoffs without explicitly giving the configurations.
So we just need to give one row of real numbers, which correspond to
payoffs for the ordered set of configurations.

If action s is in multiple players’ action sets (say players
i, j),
then it is possible that the set of possible configurations
given si
is different from the set of possible configurations given
sj.
In such cases, we need to specify payoffs for the union of the
sets of configurations (sorted in lexicographical order).



	Type 1

	The mapping representation, in which we specify the configurations
and the corresponding payoffs. For the payoff function of action s,
first give Delta_s, the number of elements in the mapping.
Then follows Delta_s rows. In each row, first specify the configuration,
which is a tuple of integers, enclosed by a pair of brackets “[” and “]”,  then the payoff.
For example, the following specifies a payoff function of type 1, with two configurations:

1 2
[1 0] 2.5
[1 1] -1.2















The Bayesian action graph game (.bagg) format

Bayesian action graph games (BAGGs) are a compact representation of Bayesian (i.e., incomplete-information) games.
For more information on BAGGs, the following paper gives a detailed discussion.


A.X. Jiang and K. Leyton-Brown, Bayesian Action-Graph Games [http://www.cs.ubc.ca/~jiang/papers/BAGG.pdf]. NIPS, 2010.




Each file in this format describes a BAGG.
In order for the file to be recognized as BAGG by GAMBIT, the initial line of the file should be:

#BAGG





The rest of the file consists of the following sections,
separated by whitespaces. Lines with starting ‘#’ are treated as comments and are allowed between sections.


	The number of Players, n.


	The number of action nodes, |S|.


	The number of function nodes, |P|.


	The number of types for each player, as a row of n integers.


	Type distribution for each player. The distributions are assumed to be independent.
Each distribution is represented as a row of real numbers.
The following example block gives the type distributions for a BAGG with two players and two types for each player:

0.5 0.5
0.2 0.8







	Size of type-action set for each player’s each type.


	Type-action set for each player’s each type.
Each type-action set is represented as a row of integers in ascending order,
which are indices of action nodes. Action nodes are indexed from 0 to |S|-1.


	The action graph: same as in the AGG format.


	types of functions: same as in the AGG format.


	utility function for each action node: same as in the AGG format.
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An overview of Gambit


What is Gambit?

Gambit is a set of software tools for doing computation on finite,
noncooperative games. These comprise a graphical interface for
interactively building and analyzing general games in extensive or
strategy form; a number of command-line tools for computing Nash
equilibria and other solution concepts in games; and, a set of file
formats for storing and communicating games to external tools.



A brief history of Gambit

The Gambit Project was founded in the mid-1980s by Richard McKelvey at
the California Institute of Technology. The original implementation
was written in BASIC, with a simple graphical interface. This code was
ported to C around 1990 with the help of Bruce Bell, and was
distributed publicly as version 0.13 in 1991 and 1992.

A major step in the evolution of Gambit took place with the awarding
of the NSF grants in 1994, with McKelvey and Andrew McLennan as
principal investigators, and Theodore Turocy [http://www.gambit-project.org/turocy] as the head programmer.
The grants sponsored a complete rewrite of Gambit in C++. The
graphical interface was made portable across platforms through the use
of the wxWidgets library (http://www.wxwidgets.org). Version 0.94 of Gambit was released in
the late summer of 1994, version 0.96 followed in 1999, and version
0.97 in 2002. During this time, many students at Caltech and Minnesota
contributed to the effort by programming, testing, and/or documenting.
These include, alphabetically, Bruce Bell, Anand Chelian, Matthew
Derer, Nelson Escobar, Ben Freeman, Eugene Grayver, Todd Kaplan, Geoff
Matters, Brian Trotter, Michael Vanier, Roberto Weber, and Gary Wu.

Over the same period, Bernhard von Stengel, of the London School of
Economics, made significant contributions in the implementation of the
sequence form methods for two-player extensive games, and for
contributing his “clique” code for identification of equilibrium
components in two-player strategic games, as well as other advice
regarding Gambit’s implementation and architecture.

Development since the mid-2000s has focused on two objectives. First,
the graphical interface was reimplemented and modernized, with the
goal of following good interaction design principles, especially in
regards to easing the learning curve for users new to Gambit and new
to game theory.  Second, the internal architecture of Gambit was
refactored to increase interoperability between the tools provided by
Gambit and those written independently.

Gambit is proud to have participated in the Google Summer of Code
program in the summers of 2011 and 2012 as a mentoring organization.
The Python API, which became part of Gambit from Gambit 13, was
developed during these summers, thanks in particular to the work
of Stephen Kunath and Alessandro Andrioni.



Key features of Gambit

Gambit has a number of features useful both for the researcher and the
instructor:

Interactive, cross-platform graphical interface. All Gambit
features are available through the use of a graphical interface, which
runs under multiple operating systems: Windows, various flavors of
Un*x (including Linux), and Mac OS X. The interface offers flexible
methods for creating extensive and strategic games. It offers an
interface for running algorithms to compute Nash equilibria, and for
visualizing the resulting profiles on the game tree or table, as well
as an interactive tool for analyzing the dominance structure of
actions or strategies in the game. The interface is useful for the
advanced researcher, but is intended to be accessible for students
taking a first course in game theory as well.

Command-line tools for computing equilibria. More advanced
applications often require extensive computing time and/or the ability
to script computations. All algorithms in Gambit are packaged as
individual, command-line programs, whose operation and output are
configurable.

Extensibility and interoperability. The Gambit tools read and
write file formats which are textual and documented, making them
portable across systems and able to interact with external tools. It
is therefore straightforward to extend the capabilities of Gambit by,
for example, implementing a new method for computing equilibria,
reimplementing an existing one more efficiently, or creating tools to
programmatically create, manipulate, and transform games, or for
econometric analysis on games.



Limitations of Gambit

Gambit has a few limitations that may be important in some
applications. We outline them here.

Gambit is for finite games only. Because of the mathematical
structure of finite games, it is possible to write many general-
purpose routines for analyzing these games. Thus, Gambit can be used
in a wide variety of applications of game theory. However, games that
are not finite, that is, games in which players may choose from a
continuum of actions, or in which players may have a continuum of
types, do not admit the same general-purpose methods.

Gambit is for noncooperative game theory only. Gambit focuses on
the branch of game theory in which the rules of the game are written
down explicitly, and in which players choose their actions
independently. Gambit’s analytical tools center primarily around Nash
equilibrium, and related concepts of bounded rationality such as
quantal response equilibrium. Gambit does not at this time provide any
representations of, or methods for, analyzing games written in
cooperative form. (It should be noted that some problems in
cooperative game theory do not suffer from the computational
complexity that the Nash equilibrium problem does, and thus
cooperative concepts could be an interesting future direction of
development.)

Analyzing large games may become infeasible surprisingly quickly.
While the specific formal complexity classes of computing Nash
equilibria and related concepts are still an area of active research,
it is clear that, in the typical case, the amount of time required to
compute equilibria increases rapidly in the size of the game. In other
words, it is quite easy to write down games which will take Gambit an
unacceptably long amount time to compute the equilibria of. There are
two ways to deal with this problem in practice. One way is to better
identify good heuristic approaches for guiding the equilibrium
computation process. Another way is to take advantage of known
features of the game to guide the process. Both of these approaches
are now becoming areas of active interest. While it will certainly not
be possible to analyze every game that one would like to, it is hoped
that Gambit will both contribute to these two areas of research, as
well as make the resulting methods available to both students and
practitioners.



Developers

The principal developers of Gambit are:


	Theodore Turocy [http://www.gambit-project.org/turocy],
University of East Anglia: director.


	Richard D. McKelvey, California Institute of Technology:
project founder.


	Andrew McLennan, University of Queensland: co-PI during main
development, developer and maintainer of polynomial-based algorithms
for equilibrium computation.




Much of the development of the main Gambit codebase took place in
1994-1996, under a grant from the National Science Foundation to the
California Institute of Technology and the University of Minnesota
(McKelvey and McLennan, principal investigators).

Others contributing to the development and distribution of Gambit
include:


	Bernhard von Stengel provided advice on implementation of
sequence form code, and contributed clique code


	Eugene Grayver developed the first version of the
graphical user interface.


	Gary Wu implemented an early scripting language interface for
Gambit (since superseded by the Python API).


	Stephen Kunath and Alessandro Andrioni did extensive work to create
the first release of the Python API.


	From Gambit 14, Gambit contains support for Action Graph Games
[Jiang11].  This has been contributed by Navin Bhat, Albert Jiang,
Kevin Leyton-Brown, and David Thompson, with funding support
provided by a University Graduate Fellowship of the University
of British Columbia, the NSERC Canada Graduate Scholarship, and a
Google Research Award to Leyton-Brown.






Downloading Gambit

Gambit operates on an annual release cycle roughly mirroring the
(northern hemisphere) academic year.  A new version is promoted to
stable/teaching each August; the major version number is equal to the
last two digits of the year in which the version becomes stable.

This document covers Gambit 16.0.2.
You can download it from
Sourceforge [http://sourceforge.net/projects/gambit/files/gambit16/16.0.1].
Full source code is available, as are precompiled binaries for
Microsoft Windows and Mac OS X.

Older versions of Gambit can be downloaded from
http://sourceforge.net/projects/gambit/files.  Support for older
versions is limited.



Community

The following mailing lists are available for those interested in the
use and further development of Gambit:


	gambit-announce@lists.sourceforge.net [http://lists.sourceforge.net/lists/listinfo/gambit-announce]

	Announcement-only mailing list for notifications of new releases of
Gambit.



	gambit-users@lists.sourceforge.net [http://lists.sourceforge.net/lists/listinfo/gambit-users]

	General discussion forum for teaching and research users of Gambit.



	gambit-devel@lists.sourceforge.net [http://lists.sourceforge.net/lists/listinfo/gambit-devel]

	Discussion for those interested in devleoping or extending Gambit,
or using Gambit source code in other applications.







Bug reports

In the first instance, bug reports or feature requests should be
posted to the Gambit issue tracker, located at
http://github.com/gambitproject/gambit/issues.

When reporting a bug, please be sure to include the following:


	The version(s) of Gambit you are using.  (If possible, it is helpful
to know whether a bug exists in both the current stable/teaching and
the current development/research versions.)


	The operating system(s) on which you encountered the bug.


	A detailed list of steps to reproduce the bug.  Be sure to include a
sample game file or files if appropriate; it is often helpful to
simplify the game if possible.
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The graphical interface

Gambit’s graphical user interface provides an
“integrated development environment” to help visually construct
games and to investigate their main strategic features.

The graphical interface is largely intended for the interactive
construction and analysis of small to medium games. Repeating the
caution from the introduction of this manual, the computation time
required for the equilibrium analysis of games increases rapidly in
the size of the game. The graphical interface is ideal for students
learning about the fundamentals of game theory, or for practitioners
prototyping games of interest.

In graduating to larger applications,
users are encouraged to make use of the underlying Gambit libraries
and programs directly.  For greater control over computing Nash and
quantal response equilibria of a game, see the section on
the command-line tools.
To build larger games or to explore parameter spaces of a game
systematically, it is recommended to use
the Python API.


General concepts


General layout of the main window

[image: the default extensive game at launch]
The frame presenting a game consists of two principal panels. The main
panel, to the right, displays the game graphically; in this case,
showing the game tree of a simple one-card poker game. To the left is
the player panel, which lists the players in the game; here, Fred and
Alice are the players. Note that where applicable, information is
color-coded to match the colors assigned to the players: Fred’s moves
and payoffs are all presented in red, and Alice’s in blue. The color
assigned to a player can be changed by clicking on the color icon
located to the left of the player’s name on the player panel. Player
names are edited by clicking on the player’s name, and editing the
name in the text control that appears.

Two additional panels are available. Selecting
Tools ‣ Dominance toggles
the display of an additional toolbar across the top of the window.
This toolbar controls the indication and elimination of actions or
strategies that are dominated. The use of this toolbar is discussed in
Investigating dominated strategies and actions.

Selecting View ‣ Profiles,
or clicking the show profiles icon on the
toolbar, toggles the display of the list of computed strategy profiles
on the game. More on the way the interface handles the computation of
Nash equilibria and other kinds of strategy profiles is presented
in Computing Nash equilibria.



Payoffs and probabilities in Gambit

Gambit stores all payoffs in games in an arbitrary-precision format.
Payoffs may be entered as decimal numbers with arbitrarily many
decimal places. In addition, Gambit supports representing payoffs
using rational numbers. So, for example, in any place in which a
payoff may appear, either an outcome of an extensive game or a payoff
entry in a strategic game, the payoff one-tenth may be entered either
as .1 or 1/10.

The advantage of this format is that, in certain circumstances, Gambit
may be able to compute equilibria exactly. In addition, some methods
for computing equilibria construct good numerical approximations to
equilibrium points. For these methods, the computed equilibria are
stored in floating-point format. To increase the number of decimal
places shown for these profiles, click the increase decimals icon . To
decrease the number of decimal places shown, click the decrease
decimals icon .

Increasing or decreasing the number of decimals displayed in
computed strategy profiles will not have any effect on the display of
outcome payoffs in the game itself, since those are stored in
arbitrary precision.



A word about file formats

The graphical interface manipulates several different file formats for
representing games. This section gives a quick overview of those
formats.

Gambit has for many years supported two file formats for representing
games, one for extensive games (typically using the filename extension
.efg) and one for strategic games (typically using the filename
extension .nfg). These file formats are recognized by all Gambit
versions dating back to release 0.94 in 1995. (Users interested in the
details of these file formats can consult Game representation formats
for more information.)

Beginning with release 2005.12.xx, the graphical interface now reads
and writes a new file format, which is referred to as a”Gambit
workbook.” This extended file format stores not only the
representation of the game, but also additional information, including
parameters for laying out the game tree, the colors assigned to
players, any equilibria or other analysis done on the game, and so
forth. So, for example, the workbook file can be used to store the
analysis of a game and then return to it. These files by convention
end in the extension .gbt.

The graphical interface will read files in all three formats: .gbt,
.efg, and .nfg. The “Save” and “Save as” commands, however, always
save in the Gambit workbook (.gbt) format. To save the game itself as
an extensive (.efg) or strategic (.nfg) game, use the items on the
“Export” submenu of the “File” menu. This is useful in interfacing
with older versions of Gambit, with other tools which read and write
those formats, and in using the underlying Gambit analysis command-
line tools directly, as those programs accept .efg or .nfg game files.
Users primarily interested in using Gambit solely via the graphical
interface are encouraged to use the workbook (.gbt) format.

As it is a new format, the Gambit workbook format is still under
development and may change in details. It is intended that newer
versions of the graphical interface will still be able to read
workbook files written in older formats.




Extensive games

The graphical interface provides a flexible set of operations for
constructing and editing general extensive games. These are outlined
below.


Creating a new extensive game

To create a new extensive game, select
File ‣ New ‣ Extensive game, or
click on the new extensive game icon . The extensive game created is a
trivial game with two players, named by default
Player 1 and Player 2,
with one node, which is both the root and terminal node of the game.
In addition, extensive games have a special player labeled
Chance,
which is used to represent random events not controlled by any of the
strategic players in the game.



Adding moves

There are two options for adding moves to a tree: drag-and-drop
and the Insert move dialog.


	Moves can be added to the
tree using a drag-and-drop idiom. From the player list window, drag
the player icon located to the left of the player who will have the
move to any terminal node in the game tree. The tree will be extended
with a new move for that player, with two actions at the new move.
Adding a move for the chance player is done the same way, except the
dice icon appearing to the left of the chance player in the player
list window is used instead of the player icon. For the chance player,
the two actions created will each be given a probability weight of
one-half. If the desired move has more than two actions, additional
actions can be added by dragging the same player’s icon to the move
node; this will add one action to the move each time this is done.




[image: insert move dialog]

	Click on any terminal node in
the tree, and select Edit ‣ Insert move
to display the insert move dialog.
The dialog is intended to read like a sentence:


	The first control specifies the player who will make the move. The
move can be assigned to a new player by specifying
Insert move for a new player here.


	The second control selects the information set to which to add the
move. To create the move in a new information set, select
at a new information set for this control.


	The third control sets the number of actions. This control is
disabled unless the second control is set to
at a new information set.
Otherwise, it is set automatically to the number of actions at
the selected information set.








The two methods can be useful in different contexts.
The drag-and-drop approach
is a bit quicker to use, especially when creating trees that have few
actions at each move. The dialog approach is a bit more flexible, in
that a move can be added for a new, as-yet-undefined player, a move
can be added directly into an existing information set, and a move can
be immediately given more than two actions.



Copying and moving subtrees

Many extensive games have structures that appear in multiple parts of
the tree. It is often efficient to create the structure once, and then
copy it as needed elsewhere.

Gambit provides a convenient idiom for this. Clicking on any
nonterminal node and dragging to any terminal node implements a move
operation, which moves the entire subtree rooted at the original,
nonterminal node to the terminal node.

To turn the operation into a copy operation:


	On Windows and Linux systems, hold down the Ctrl key during
the operation.


	On OS X, hold down the Cmd key when starting the
drag operation, then release prior to dropping.




The entire subtree rooted at the original node is copied,
starting at the terminal node. In this copy operation, each node in
the copied image is placed in the same information set as the
corresponding node in the original subtree.

Copying a subtree to a terminal node in that subtree is also
supported. In this case, the copying operation is halted when reaching
the terminal node, to avoid an infinite loop. Thus, this feature
can also be helpful in constructing multiple-stage games.



Removing parts of a game tree

Two deletion operations are supported on extensive games. To delete
the entire subtree rooted at a node, click on that node and select
Edit ‣ Delete subtree.

To delete an individual move from the game, click on one of the direct
children of that node, and select
Edit ‣ Delete parent. This operation
deletes the parent node, as well as all the children of the parent
other than the selected node. The selected child node now takes the
place of the parent node in the tree.



Managing information sets

Gambit provides several methods to help manage the information
structure in an extensive game.

When building a tree, new moves can be placed in a given information
set using the Insert move dialog.
Additionally, new moves can be
created using the drag-and-drop idiom by holding down the Shift
key and dragging a node in the tree. During the drag operation, the
cursor changes to the move icon . Dropping the move icon on another
node places the target node in the same information set as the node
where the drag operation began.

[image: node properties dialog]
The information set to which a node belongs can also be set by
selecting Edit ‣ Node.  This displays the
node properties dialog.
The Information set dropdown defaults
to the current information set to which the node belongs, and contains
a list of all other information sets in the game which are compatible
with the node, that is, which have the same number of
actions. Additionally, the node can be moved to a new, singleton
information set by setting this dropdown to the New
information set entry.

When building out a game tree using the drag-and-drop approach to copying portions of the tree,
the nodes created in
the copy of the subtree remain in the same information set as the
corresponding nodes in the original subtree. In many cases, though,
these trees differ in the information available to some or all of the
players. To help speed the process of adjusting information sets in
bulk, Gambit offers a “reveal” operation, which breaks information
sets based on the action taken at a particular node. Click on a node
at which the action taken is to be made known subsequently to other
players, and select Edit ‣ Reveal.  This displays a
dialog listing the players in the game. Check the boxes next to the
players who observe the outcome of the move at the node, and click
OK.  The information sets at nodes below the selected one
are adjusted based on the action selected at this node.

This is an operation that is easier to see than the explain. See the
poker tutorial
(flash version [http://www.gambit-project.org/doc/tutorials/poker.swf];
PDF version [http://www.gambit-project.org/doc/tutorials/poker.pdf])
for an application of the
revelation operation in conjunction with the tree-copy operation.


Note

The reveal operation only has an effect at the time it is done. In
particular, it does not enforce the separation of information sets
based on this information during subsequent editing of the game.
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Command-line tools

Gambit provides command-line interfaces for each method for computing
Nash equilibria.  These are suitable for scripting or calling from
other programs.  This chapter describes the use of these programs.
For a general overview of methods for computing equilibria,
see the survey of [McKMcL96].

The graphical interface also provides a frontend for calling these
programs and evaluating their output.  Direct use of the command-line
programs is intended for advanced users and applications.

These programs take an extensive or strategic game file, which can be
specified on the command line or piped via standard input, and output
a list of equilibria computed. The default output format is to present
equilibria computed as a list of comma-separated probabilities,
preceded by the tag NE. For mixed strategy profiles, the
probabilities are sorted lexicographically by player, then by
strategy.  For behavior strategy profiles, the probabilites are sorted
by player, then information set, then action number, where the
information sets for a player are sorted by the order in which they
are encountered in a depth-first traversal of the game tree.
Many programs take an option -D, which, if specified, instead prints
a more verbose, human-friendly description of each strategy profile
computed.

Many of the programs optionally output additional information
about the operation of the algorithm.  These outputs have other,
program-specific tags, described in the individual program
documentation.


gambit-enumpure: Enumerate pure-strategy equilibria of a game

gambit-enumpure reads a game on standard input and searches for
pure-strategy Nash equilibria.


Changed in version 14.0.2: The effect of the -S switch is now purely cosmetic, determining
how the equilibria computed are represented in the
output. Previously, -S computed using the strategic game; if this
was not specified for an extensive game, the agent form equilibria
were returned.




	
-S

	Report equilibria in reduced strategic form strategies, even if the
game is an extensive game.  By default, if passed an extensive
game, the output will be in behavior strategies.  Specifying this switch
does not imply any change in operation internally, as pure-strategy
equilibria are defined in terms of reduced strategic form
strategies.






	
-D

	
New in version 14.0.2.



The default output format for computed equilibria is a
comma-separated list of strategy or action probabilities, suitable
for postprocessing by automated tools.  Specifying -D instead
causes the program to output greater detail on each equilbrium
profile computed.






	
-A

	
New in version 14.0.2.



Report agent form equilibria, that is, equilibria which consider
only deviations at one information set.  Only has an effect for
extensive games, as strategic games have only one information set
per player.






	
-P

	By default, the program computes all pure-strategy Nash
equilibria in an extensive game. This switch instructs the program to
find only pure-strategy Nash equilibria which are subgame perfect.
(This has no effect for strategic games, since there are no proper
subgames of a strategic game.)






	
-h

	Prints a help message listing the available options.






	
-q

	Suppresses printing of the banner at program launch.





Computing the pure-strategy equilibria of extensive game e02.efg, the example in Figure 2 of Selten
(International Journal of Game Theory, 1975):

$ gambit-enumpure e02.efg
Search for Nash equilibria in pure strategies
Gambit version 16.0.2, Copyright (C) 1994-2022, The Gambit Project
This is free software, distributed under the GNU GPL

NE,1,0,0,0,1,0





With the -S switch, the set of equilibria returned is the same,
except expressed in strategic game strategies rather than behavior
strategies:

$ gambit-enumpure -S e02.efg
Search for Nash equilibria in pure strategies
Gambit version 16.0.2, Copyright (C) 1994-2022, The Gambit Project
This is free software, distributed under the GNU GPL

NE,1,0,0,1,0





The -A switch considers only behavior strategy profiles where there
is no way for a player to improve his payoff by changing action at
only one information set; therefore the set of solutions is larger:

$ gambit-enumpure -A e02.efg
Search for Nash equilibria in pure strategies
Gambit version 16.0.2, Copyright (C) 1994-2022, The Gambit Project
This is free software, distributed under the GNU GPL

NE,1,0,1,0,1,0
NE,1,0,1,0,0,1
NE,1,0,0,1,1,0







gambit-enumpoly: Compute equilibria of a game using polynomial systems of equations

gambit-enumpoly reads a game on standard input and
computes Nash equilibria by solving systems of polynomial equations
and inequalities.

This program searches for all Nash equilibria in a strategic game
using a support enumeration approach. This approach computes all the
supports which could, in principle, be the support of a Nash
equilibrium, and then searches for a totally mixed equilibrium on that
support by solving a system of polynomial equalities and inequalities
formed by the Nash equilibrium conditions. The ordering of the
supports is done in such a way as to maximize use of previously
computed information, making it suited to the computation of all Nash
equilibria.

When the verbose switch -v is used, the program outputs each support
as it is considered. The supports are presented as a comma-separated
list of binary strings, where each entry represents one player. The
digit 1 represents a strategy which is present in the support, and the
digit 0 represents a strategy which is not present. Each candidate
support is printed with the label “candidate,”.

Note that the subroutine to compute a solution to the system of
polynomial equations and inequalities will fail in degenerate cases.
When the verbose switch -v is used, these supports are identified on
standard output with the label “singular,”. It is possible that there
exist equilibria, often a connected component of equilibria, on these
singular supports.


	
-d

	Express all output using decimal representations with the specified
number of digits.






	
-h

	Prints a help message listing the available options.






	
-H

	By default, the program uses an enumeration method designed to
visit as few supports as possible in searching for all equilibria.
With this switch, the program uses a heuristic search method based on
Porter, Nudelman, and Shoham [PNS04], which is designed to minimize the
time until the first equilibrium is found. This switch only has an
effect when solving strategic games.






	
-S

	By default, the program uses behavior strategies for extensive
games; this switch instructs the program to use reduced strategic game
strategies for extensive games. (This has no effect for strategic
games, since a strategic game is its own reduced strategic game.)






	
-q

	Suppresses printing of the banner at program launch.






	
-v

	Sets verbose mode. In verbose mode, supports are printed on
standard output with the label “candidate” as they are considered, and
singular supports are identified with the label “singular.” By
default, no information about supports is printed.





Computing equilbria of the extensive game e01.efg, the example in Figure 1 of Selten
(International Journal of Game Theory, 1975) sometimes called
“Selten’s horse”:

$ gambit-enumpoly e01.efg
Compute Nash equilibria by solving polynomial systems
Gambit version 16.0.2, Copyright (C) 1994-2022, The Gambit Project
Heuristic search implementation Copyright (C) 2006, Litao Wei
This is free software, distributed under the GNU GPL

NE,0.000000,1.000000,0.333333,0.666667,1.000000,0.000000
NE,1.000000,0.000000,1.000000,0.000000,0.250000,0.750000
NE,1.000000,0.000000,1.000000,0.000000,0.000000,0.000000
NE,0.000000,1.000000,0.000000,0.000000,1.000000,0.000000







gambit-enummixed: Enumerate equilibria in a two-player game

gambit-enummixed reads a two-player game on standard input and
computes Nash equilibria using extreme point enumeration.

In a two-player strategic game, the set of Nash equilibria can be expressed
as the union of convex sets.  This program generates all the extreme
points of those convex sets. (Mangasarian [Man64])
This is a superset of the points generated by the path-following
procedure of Lemke and Howson (see gambit-lcp: Compute equilibria in a two-player game via linear complementarity).  It was
shown by Shapley [Sha74] that there are equilibria not accessible via
the method in gambit-lcp: Compute equilibria in a two-player game via linear complementarity, whereas the output of
gambit-enummixed is guaranteed to return all the extreme
points.


	
-d

	By default, this program computes using exact
rational arithmetic. Since the extreme points computed by this method
are guaranteed to be rational when the payoffs in the game are
rational, this permits exact computation of the equilibrium set.
Computation using rational arithmetic is in general slow, however. For
most games, acceptable results can be obtained by computing using the
computer’s native floating-point arithmetic. Using this flag enables
computation in floating-point, and expresses all output using decimal
representations with the specified number of digits.






	
-D

	Since all Nash equilibria involve only strategies which survive
iterative elimination of strictly dominated strategies, the program
carries out the elimination automatically prior to computation.
This is recommended, since it almost always results in superior
performance.
Specifying -D skips the elimination step and performs the
enumeration on the full game.






	
-c

	The program outputs the extreme equilibria as it finds them,
prefixed by the tag NE . If this option is specified, once all extreme
equilbria are identified, the program computes the convex sets which
make up the set of equilibria. The program then additionally outputs
each convex set, prefixed by convex-N , where N indexes the set. The
set of all equilibria, then, is the union of these convex sets.






	
-h

	Prints a help message listing the available options.






	
-q

	Suppresses printing of the banner at program launch.






	
-L

	Use lrslib [http://cgm.cs.mcgill.ca/~avis/C/lrs.html] by David Avis
to carry out the enumeration process.  This is an experimental
feature that has not been widely tested.





Computing the equilibria, in mixed strategies, of e02.nfg, the reduced strategic form of the example
in Figure 2 of Selten (International Journal of Game Theory,
1975):

$ gambit-enummixed e02.nfg
Compute Nash equilibria by enumerating extreme points
Gambit version 16.0.2, Copyright (C) 1994-2022, The Gambit Project
Enumeration code based on lrslib 4.2b,
Copyright (C) 1995-2005 by David Avis (avis@cs.mcgill.ca)
This is free software, distributed under the GNU GPL

NE,1,0,0,1,0
NE,1,0,0,1/2,1/2





In fact, the game e02.nfg has a one-dimensional continuum of
equilibria.  This fact can be observed by examining the connectedness
information using the -c switch:

$ gambit-enummixed -c e02.nfg
Compute Nash equilibria by enumerating extreme points
Gambit version 16.0.2, Copyright (C) 1994-2022, The Gambit Project
Enumeration code based on lrslib 4.2b,
Copyright (C) 1995-2005 by David Avis (avis@cs.mcgill.ca)
This is free software, distributed under the GNU GPL

NE,1,0,0,1,0
NE,1,0,0,1/2,1/2
convex-1,1,0,0,1/2,1/2
convex-1,1,0,0,1,0







gambit-gnm: Compute Nash equilibria in a strategic game using a global Newton method

gambit-gnm reads a game on standard input and computes Nash
equilibria using a global Newton method approach developed by Govindan
and Wilson [GovWil03]. This program is a wrapper around the
Gametracer 0.2 [http://dags.stanford.edu/Games/gametracer.html]
implementation by Ben Blum and Christian Shelton.


	
-d

	Express all output using decimal representations
with the specified number of digits.






	
-h

	Prints a help message listing the available options.






	
-n

	Randomly generate the specified number of perturbation vectors.






	
-q

	Suppresses printing of the banner at program launch.






	
-s

	Specifies a file containing a list of starting points
for the algorithm. The format of the file is comma-separated values,
one mixed strategy profile per line, in the same format used for
output of equilibria (excluding the initial NE tag).






	
-v

	Show intermediate output of the algorithm.  If this option is
not specified, only the equilibria found are reported.





Computing an equilibrium of e02.nfg,
the reduced strategic form of the example in Figure 2 of Selten
(International Journal of Game Theory, 1975):

$ gambit-gnm e02.nfg
Compute Nash equilibria using a global Newton method
Gametracer version 0.2, Copyright (C) 2002, Ben Blum and Christian Shelton
Gambit version 16.0.2, Copyright (C) 1994-2022, The Gambit Project
This is free software, distributed under the GNU GPL

NE,1,0,2.99905e-12,0.5,0.5






Note

This is an experimental program and has not been extensively tested.
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Python interface to Gambit library

Gambit provides a Python interface for programmatic manipulation of
games.  This section documents this interface, which is under active
development.  Refer to the instructions for building the Python
interface to compile and install the Python extension.


Note

Prior to 16.0.1, the Python extension was named gambit.
It is now known as pygambit to avoid a name clash with an
unrelated (and abandoned) project on PyPI.
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Sample games


	2x2x2.nfg

	A three-player normal form game with two strategies per player.
This game has nine Nash equilibria,
which is the maximal number of regular Nash equilibria possible
for a game of this size. See
McKelvey, Richard D. and McLennan, Andrew (1997).
The maximal number of regular totally mixed Nash equilibria.
Journal of Economic Theory 72(2): 411-425. [http://dx.doi.org/10.1006/jeth.1996.2214]



	2x2x2-nau.nfg

	A three-player normal form game with two strategies per player.
This game has three pure strategy equilibria, two
equilibria which are incompletely mixed, and a continuum of
completely mixed equilibria. This game appears as an example in
Nau, Robert, Gomez Canovas, Sabrina, and Hansen, Pierre (2004).
On the geometry of Nash equilibria and correlated equilibria.
International Journal of Game Theory 32(4): 443-453. [http://dx.doi.org/10.1007/s001820300162]



	bagwell.efg

	Stackelberg leader game with imperfectly observed commitment,
from Bagwell, Kyle (1993) Commitment and observability in games.
Games and Economic Behavior 8: 271-280. [http://dx.doi.org/10.1016/S0899-8256(05)80001-6]



	bayes2a.efg

	A twice-repeated Bayesian game, with two players, each having two
types and two actions. This game also illustrates the use of payoffs
at nonterminal nodes in Gambit, which can substantially simplify the
representation of multi-stage games such as this.



	cent3.efg

	A three-stage centipede game, featuring an exogenous probability
that one player is an altruistic type, who always passes.
See, for example,
McKelvey, Richard D. and Palfrey, Thomas R. (1992) An
experimental study of the centipede game.  Econometrica 60(4):
803-836. [http://www.jstor.org/stable/2951567]



	condjury.efg

	A three-person Condorcet jury game, after the analysis of
Feddersen, Timothy and Pesendorfer, Wolfgang (1998)
Convicting the innocent: The inferiority of unanimous jury verdicts
under strategic voting. American Political Science Review 92(1):
23-35. [http://www.jstor.org/stable/2585926].



	loopback.nfg

	A game due to McKelvey which illustrates that the logit quantal
response equilibrium correspondence can have a “backward-bending”
segment on the principal branch.



	montyhal.efg

	The famous
Monty Hall problem [http://en.wikipedia.org/wiki/Monty_Hall_problem]: if Monty offers
to let you switch doors, should you?



	nim.efg

	The classic game of
Nim [http://en.wikipedia.org/wiki/Nim], which is a useful example
of the value of backward induction. This version starts with five
stones.  An interesting experimental study of this class of games is
McKinney, C. Nicholas and Van Huyck, John B. (2013) Eureka
learning: Heuristics and response time in perfect information
games. Games and Economic Behavior 79:
223-232. [http:dx.doi.org/10.1016/j.geb.2013.02.003]



	pbride.efg

	A signaling game from
Joel Watson’s Strategy textbook [http://books.wwnorton.com/books/detail.aspx?ID=4294969499],
modeling the confrontation in The Princess Bride between Humperdinck
and Roberts in the bedchamber.



	poker.efg

	A simple game of one-card poker introduced in
Myerson, Roger (1991) Game Theory: Analysis of Conflict. [http://www.hup.harvard.edu/catalog.php?isbn=9780674341166].
A bit unusually for poker, the “fold” action by a player with a
strong hand counts for a win for that player, so folding is only
weakly rather than strictly dominated in this case.



	4cards.efg

	A slightly more complex poker example, contributed by Alix Martin.



	spence.efg

	A version of Spence’s classic job-market signaling game. This version
comes from Joel Watson’s Strategy textbook [http://books.wwnorton.com/books/detail.aspx?ID=4294969499].





These games, and others, ship in the standard Gambit source
distribution in the directory contrib/games.
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For contributors: Ideas and suggestions for Gambit-related projects

Research on doing computation on finite games, and using numerical and
algorithmic methods to analyze games, are areas of quite active
research.  There are a number of opportunities for programmers of all
skill levels and backgrounds to contribute to improving and extending
Gambit.

A number of such ideas are outlined in this section.
Each project includes the required implementation environment,
and a summary of the background prerequisites
someone should have in order to take on the project successfully, in
terms of mathematics, game theory, and software engineering.

Students who are interested in applying to participate in the
Google Summer of Code program should also first read our
introductory document and application template at
http://www.gambit-project.org/application.txt.

For beginning contibutors - especially those who are interested
in potentially applying to work on Gambit projects in future
Google Summer of Code editions - there are a number of
issues in the Gambit issue tracker tagged as “easy” [https://github.com/gambitproject/gambit/issues?labels=easy&sort=created&direction=desc&state=open&page=1].
These are excellent ways to get familiar with the Gambit codebase.
Contributors who have completed one or more such easy tasks will have
a significantly greater chance of being considered for possible
GSoC work.

The Gambit source tree [http://gambit.git.sourceforge.net/git/gitweb-index.cgi] is managed
using git [http://www.git-scm.com].  It is recommended to have some
familiarity with how git works, or to be willing to learn.  (It’s not
that hard, and once you do learn it, you’ll wonder how you ever lived
without it.)

This section lists project ideas pertaining to the Gambit library
and desktop interface.  There are additional project opportunities
in the Game Theory Explorer web/cloud interface.  These are
listed separately here [http://gte.csc.liv.ac.uk/index/index.html#document-ideas].


Refactor and update game representation library

The basic library (in src/libgambit) for representing games was
written in the mid-1990s.  As such, it predates many modern C++
features (including templates, STL, exceptions, Boost, and so on).
There are a number of projects for taking existing functionality,
refactoring it into separate components, and then enhancing what
those components can do.


File formats for serializing games

Gambit supports a number of file formats for reading and writing
games.  There are traditional formats for extensive and strategic
games.  The graphical interface wraps these formats into an XML
document which can store additional metadata about the game.  The Game
Theory Explorer also defines an XML format for storing games.  And,
from Gambit 14, there is a special file format for representing
games in action graph format.

Separately, Gambit has a command-line tool for outputting games in
HTML and LaTeX formats.

This project would refactor these features into a unified framework
for reading and writing games in various formats.  It would include:


	Migrating the XML manipulation code from the graphical interface
into the basic game representation library.


	Implementing in C++ the reader/writer for Game Theory Explorer files
(a first version of this is available in Python in the gambit.gte
module).


	Unifying the gambit-nfg2tex and
gambit-nfg2html command line tools into a
gambit-convert tool, which would convert from and to many
file formats.


	Extend all the Gambit command-line tools to read files of any
accepted format, and not just .efg and .nfg files.


	Languages: C++; Python/Cython optional; XML experience helpful


	Prerequisites: Introductory game theory for familiarity with
terminology of the objects in a game; undergraduate-level software
engineering experience.






Structure equilibrium calculations using the strategy pattern

Gambit’s architecture packages methods for finding Nash equilibria as
standalone command-line tools.  Owing to different histories in
implementing these methods, internally the interfaces to these methods
at the C++ level are quite heterogeneous.  In some cases, something
like the “strategy pattern” has been used to encapsulate these
algorithms.  In others, the interface is simply a global-scope
function call with little or no structured interface.

This project would involve organizing all these interfaces in a
consistent and unified way using the “strategy pattern.”  One can see
an emerging structure in the gambit-enumpure
implementation at src/tools/enumpure/enumpure.cc in the master
branch of the git repository.  The idea would be to develop a unified
framework for being able to interchange methods to compute Nash
equilibria (or other concepts) on games.  If the project were to go
well, as an extension these interfaces could then be wrapped in the
Python API for direct access to the solvers (which are currently
called via the command-line tools).


	Languages: C++.


	Prerequisites: Introductory game theory for familiarity with
terminology of the objects in a game; undergraduate-level software
engineering experience.






Implement Strategic Restriction of a game in C++

Gambit has a concept of a StrategySupport (defined in
src/libgambit/stratspt.h and src/libgambit/stratspt.cc),
which is used, among other things, to represent a game where strictly
dominated strategies have been eliminated (which can be useful in
improving the efficiency of equilibrium computations).  The
implementation of this has historically been awkward.  Proper OO
design would suggest that a StrategySupport should be
able to be used anywhere a Game could be used, but this
is not the case.  In practice, a StrategySupport has just
been a subset of the strategies of a game, which has to be passed
along as a sidecar to the game in order to get anything done.

Recently, in the Python API, the model for dealing with this has been
improved.  In Python, there is a StrategicRestriction
of a game, which in fact can be used seamlessly anyplace a game can be
used.  Separately, there is a StrategySupportProfile,
which is basically just a subset of strategies of a game.  This
separation of concepts has proven to be clean and useful.

The project would be to develop the concept of a strategic restriction
in C++, using the Python API as a model, with the idea of ultimately
replacing the StrategySupport.


	Languages: C++; Python/Cython useful for understanding the
current implementation in Python.


	Prerequisites: Introductory game theory for familiarity with
terminology of the objects in a game; undergraduate-level software
engineering experience.






Implement Behavior Restriction of a game in Python

The Python API has a concept of a StrategicRestriction of
a game, which is the restriction of a game to a subset of strategies
for each player.  This restriction can be used seamlessly anywhere a
game can be used.

This project would develop a parallel concept of a
BehaviorRestriction.  Logically this is similar to a
StrategicRestriction, except that instead of operating on
the set of reduced strategic game strategies, it would operate on
behavior strategies (actions at information sets) in a game tree.

This is a bit more challenging than the
StrategicRestriction because of the need to be able to
traverse the resulting game tree.  Removing actions from a game can
result in entire subtrees of the game being removed, which can then
include the removal of information sets from the game so restricted.

The idea of this project is to carry out the implementation in
Python/Cython first, as the experience from the strategic restriction
project was that the more rapid prototyping possible in Python was a
big help.  However, as the ultimate goal will be to provide this at
the C++ level, there is also the possibility of attacking the problem
directly in C++ as well.


	Langauges: Python/Cython; C++.


	Prerequisites: Introductory game theory for familiarity with
terminology of the objects in a game; undergraduate-level software
engineering experience.







Implementing algorithms for finding equilibria in games

Each of the following are separate ideas for open projects on
computing equilibria and other interesting quantities on games.
Each of these is a single project  For GSoC applications, you should
select exactly one of these, as each is easily a full summer’s worth
of work (no matter how easy some of them may seem at first read!)


Enumerating all equilibria of a two-player bimatrix game using the EEE algorithm

The task is to implement the EEE algorithm, which is a published algorithm to
enumerate all extreme equilibria of a bimatrix game.


	Languages: C, Java


	Prerequisites:  Background in game theory, basic linear
algebra and linear programming.  Experience with programs of at least
medium complexity so that existing code can be expanded.




Fuller details:

The task is to implement the EEE algorithm, which is a published algorithm to
enumerate all extreme equilibria of a bimatrix game.

The most up-to-date version can be found in Sections 7 and 8
of


D. Avis, G. Rosenberg, R. Savani, and B. von Stengel (2010),
Enumeration of Nash equilibria for two-player games.
Economic Theory 42, 9-37.

http://www.maths.lse.ac.uk/Personal/stengel/ETissue/ARSvS.pdf




Extra information, including some code,
is provided in the following report:


G. Rosenberg (2004),
Enumeration of All Extreme Equilibria of Bimatrix Games with Integer Pivoting and Improved Degeneracy Check.
CDAM Research Report LSE-CDAM-2004-18.

http://www.cdam.lse.ac.uk/Reports/Files/cdam-2005-18.pdf




The original algorithm was described in the following paper:


C. Audet, P. Hansen, B. Jaumard, and G. Savard (2001),
Enumeration of all extreme equilibria of bimatrix games.
SIAM Journal on Scientific Computing 23, 323–338.




The implementation should include a feature to compare the
algorithm’s output (a list of extreme equilibria) with the
ouput of other algorithms for the same task (e.g.
lrsnash).

In addition a framework that compares running times (and the
number of recursive calls, calls to pivoting methods, and
other crucial operations) should be provided.
The output should record and document the computational
experiments so that they can be reproduced, in a general
setup - sufficiently documented - that can be used for
similar comparisons.



Improve integration and testing of Gametracer

Gambit incorporates the
Gametracer [http://dags.stanford.edu/Games/gametracer.html] package
to provide
implementations of two methods for computing equilibria,
gambit-gnm and gambit-ipa.
The integration
is rather crude, as internally the program converts the game
from native Gambit representation into Gametracer’s
representation, and the converts the output back.  Using
Gametracer’s implementations as a starting point, refactor
the implementation to use Gambit’s native classes directly,
and carry out experiments on the reliability and performance
of the algorithms.


	Languages: C++


	Prerequisites: Some level of comfort with linear algebra;
enjoyment of refactoring code.






Interface with lrslib

Gambit’s gambit-enummixed tool computes all
extreme Nash equilibria of a two-player game.  There is another
package, lrslib by David Avis [http://cgm.cs.mcgill.ca/~avis/C/lrs.html], which implements the
same algorithm more efficiently and robustly.  There is a partial
interface with an older version of lrslib in the Gambit source tree,
which has proven not to be very reliable.  The project is to complete
the integration and testing of the lrslib integration.


	Languages: C/C++


	Prerequisites: Some level of comfort with linear algebra.






Finding equilibria reachable by Lemke’s algorithm with varying “covering vectors”

Related to the Lemke-Howson method above, but with a
slightly different algorithm that has an extra parameter,
called the “covering vector”.  That parameter can serve a
randomly selected starting point of the computation and
potentially reach many more equilibria.


	Prerequisites: Theoretical understanding of the Lemke-Howson
method or of the Simplex algorithm for Linear Programming.
Literature exists that is accessible for students with at
least senior-level background in computer science,
mathematics or operations research.  An existing
implementation of a Lemke-Howson style pivoting algorithm
should be adapted with suitable alterations.






Computing the index of an equilibrium component

The task is to implement a published algorithm to compute
the so-called index of an equilibrium component in a
bimatrix game.  This component is the output to an existing
enumeration algorithm.


	Languages: C


	Prerequisites:  Senior-level mathematics, interest in game theory
and some basic topology.




Fuller details:

The aim of this project is to implement an existing
algorithm that finds the index of an equilibrium component.
The relevant description of this is chapter 2 of


Anne Balthasar, Geometry and Equilibria in Bimatrix Games,
PhD Thesis, London School of Economics, 2009.

http://www.maths.lse.ac.uk/Personal/stengel/phds/#anne





	which are pages 21-41 of

	http://www.maths.lse.ac.uk/Personal/stengel/phds/anne-final.pdf





The mathematics in this chapter are pretty scary (in
particular section 2.2, which is however not needed) but the
final page 41 which describes the algorithm is less scary.

Nevertheless, this is rather advanced material because it
builds on several different existing algorithms (for finding
extreme equilibria in bimatrix games, and “cliques” that
define convex sets of equilibria, and their non-disjoint
unions that define “components”).  It requires the
understanding of what equilibria in bimatrix games are
about.  These algorithms are described in


D. Avis, G. Rosenberg, R. Savani, and B. von Stengel (2010),
Enumeration of Nash equilibria for two-player games.
Economic Theory 42, 9-37.

http://www.maths.lse.ac.uk/Personal/stengel/ETissue/ARSvS.pdf




and students who do not eventually understand that text
should not work on this project.  For this reason, at least
senior-level (= third year) mathematics is required in terms of
mathematical maturity.  In the Avis et al. (2010) paper,
pages 19-21 describe the lexicographic method for pivoting
as it is used in the simplex method for linear programming.
A variant of this lexicographic method is used in the
chapter by Anne Balthasar.  Understanding this is a
requirement to work on this project (and a good test of how
accessible all this is).

We give here two brief examples that supplement the above
literature.  Consider the following bimatrix game.  It is
very simple, and students of game theory may find it useful
to first find out on their own what the equilibria of this
game are:

2 x 2 Payoff matrix A:

1  1
0  1

2 x 2 Payoff matrix B:

1  1
0  1

EE = Extreme Equilibrium, EP = Expected Payoff

EE  1  P1:  (1)  1  0  EP=  1  P2:  (1)  1  0  EP=  1
EE  2  P1:  (1)  1  0  EP=  1  P2:  (2)  0  1  EP=  1
EE  3  P1:  (2)  0  1  EP=  1  P2:  (2)  0  1  EP=  1

Connected component 1:
{1, 2}  x  {2}
{1}  x  {1, 2}





This shows the following:  there are 3 Nash equilibria,
which partly use the same strategies of the two players,
which are numbered (1), (2)  for each player.  It will take
a bit of time to understand the above output.  For our
purposes, the bottom “component” is most relevant:
It has two lines, and  {1, 2}  x  {2}   means
that equilibrium (1),(2)  -  which is according to the
previous list the strategy pair (1,0), (1,0)  as well as
(2),(2),   which is   (0,1), (1,0)  are “extreme
equilibria”, and moreover any convex combination of (1) and
(2) of player 1  - this is the first {1, 2} - can be
combined with strategy (2) of player 2.
This is part of the “clique” output of Algorithm 2 on page
19 of Avis et al. (2010).
There is a second such convex set of equilibria in the
second line, indicated by {1}  x  {1, 2}.
Moreover, these two convex sets intersect (in the
equilibrium  (1),(2))  and form therefore a “component” of
equilibria.  For such a component, the index has to be
found, which happens to be the integer 1 in this case.

The following bimatrix game has also two convex sets of Nash
equilibria, but they are disjoint and therefore listed as
separate components on their own:

3 x 2 Payoff matrix A:

1  1
0  1
1  0

3 x 2 Payoff matrix B:

2  1
0  1
0  1

EE = Extreme Equilibrium, EP = Expected Payoff

Rational Output

EE  1  P1:  (1)    1    0    0  EP=  1  P2:  (1)  1  0  EP= 2
EE  2  P1:  (2)  1/2  1/2    0  EP=  1  P2:  (2)  0  1  EP= 1
EE  3  P1:  (3)  1/2    0  1/2  EP=  1  P2:  (1)  1  0  EP= 1
EE  4  P1:  (4)    0    1    0  EP=  1  P2:  (2)  0  1  EP= 1

Connected component 1:
{1, 3}  x  {1}

Connected component 2:
{2, 4}  x  {2}





Here the first component has index 1 and the second has
index 0.  One reason for the latter is that if the game is
slightly perturbed, for example by giving a slightly lower
payoff than 1 in row 2 of the game, then the second strategy
of player 1 is strictly dominated and the equilibria (2) and
(4) of player 1, and thus the entire component 2, disappear
altogether.  This can only happen if the index is zero, so
the index gives some useful information as to whether an
equilibrium component is “robust” or “stable” when payoffs
are slightly perturbed.



Enumerating all equilibria of a two-player game tree

Extension of an existing algorithm for enumerating all
equilibria of a bimatrix game to game trees with imperfect
information using the so-called “sequence form”.  The method
is described in abstract form but not implemented.


	Langauges: C++


	Prerequisites: Background in game theory and basic linear
algebra.  Experience with programs of at least
medium complexity so that existing code can be expanded.






Solving for equilibria using polynomial systems of equations

The set of Nash equilibrium conditions can be expressed as a
system of polynomial equations and inequalities.  The field
of algebraic geometry has been developing packages to
compute all solutions to a system of polynomial equations.
Two such packages are
PHCpack [http://www.math.uic.edu/~jan/download.html"] and
Bertini [http://www.nd.edu/~sommese/bertini/].
Gambit has an
experimental interface, written in Python, to build the
required systems of equations, call out to the solvers, and
identify solutions corresponding to Nash equilibria.
Refactor the implementation to be more flexible and
Pythonic, and carry out experiments on the reliability and
performance of the algorithms.


	Languages: Python


	Prerequisites: Experience with text processing to pass data to
and from the external solvers.






Implement Herings-Peeters homotopy algorithm to compute Nash equilibria

Herings and Peeters
(Economic Theory, 18(1), 159-185, 2001 [http://dx.doi.org/10.1007/PL00004129]) have proposed a
homotopy algorithm to compute Nash equilibria.  They have
created a
first implementation of the method in Fortran [http://www.personeel.unimaas.nl/r.peeters/software.htm],
using hompack [http://www.netlib.org/hompack/].
Create a Gambit implementation of this method, and carry out
experiments on the reliability and performance of the
algorithms.


	Languages: C/C++, ability to at least read Fortran


	Prerequisites: Basic game theory and knowledge of pivoting
algorithms like the Simplex method for Linear Programming or
the Lemke-Howson method for games.  Senior-level
mathematics, mathematical economics, or operations research.
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For developers: Building Gambit from source

This section covers instructions for building Gambit from source.
This is for those who are interested in developing Gambit, or who
want to play around with the latest features before they make it
into a pre-compiled binary version.

This section requires at least some familiarity with programming.
Most users will want to stick with binary distributions; see
Downloading Gambit for how to get the current version for
your operating system.


General information

Gambit uses the standard autotools mechanism for configuring and building.
This should be familiar to most users of Un*ces and MacOS X.

If you are building from a source tarball,
you just need to unpack the sources, change directory to the top level
of the sources (typically of the form gambit-xx.y.z), and do the
usual

./configure
make
sudo make install





Command-line options are available to modify the configuration process;
do ./configure –help for information.  Of these, the option which
may be most useful is to disable the build of the graphical interface

By default Gambit will be installed in /usr/local.  You can change this
by replacing configure step with one of the form

./configure --prefix=/your/path/here






Note

The graphical interface relies on external calls to other
programs built in this process, especially for the computation of
equilibria.  It is strongly recommended that you install the Gambit
executables to a directory in your path!
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Game representation formats

This section documents the file formats recognized by Gambit. These
file formats are text-based and designed to be readable and editable
by hand by humans to the extent possible, although programmatic tools
to generate and manipulate these files are almost certainly needed for
all but the most trivial of games.

These formats can be viewed as being low-level. They define games
explicitly in terms of their structure, and do not support any sort of
parameterization, macros, and the like. Thus, they are adapted largely
to the type of input required by the numerical methods for computing
Nash equilibria, which only apply to a particular realization of a
game’s parameters. Higher-level tools, whether the graphical interface
or scripting applications, are indicated for doing parametric analysis
and the like.


Conventions common to all file formats

Several conventions are common to the interpretation of the file
formats listed below.

Whitespace is not significant. In general, whitespace (carriage
returns, horizontal and vertical tabs, and spaces) do not have an
effect on the meaning of the file. The only exception is inside
explicit double-quotes, where all characters are significant. The
formatting shown here is the same as generated by the Gambit code and
has been chosen for its readability; other formattings are possible
(and legal).

Text labels. Most objects in an extensive game may be given
textual labels. These are prominently used in the graphical interface,
for example, and it is encouraged for users to assign nonempty text
labels to objects if the game is going to be viewed in the graphical
interface. In all cases, these labels are surrounded by the quotation
character (“). The use of an explicit ” character within a text label
can be accomplished by preceding the embedded ” characters with a
backwards slash ().
Example 5-1. Escaping quotes in a text label

This is an alternate version of the first line of the example file, in
which the title of the game contains the term Bayesian game in
quotation marks.

EFG 2 R "An example of a \"Bayesian game\"" { "Player 1" "Player 2" }





Numerical data. yNumerical data, namely, the payoffs at outcomes,
and the action probabilities for chance nodes, may be expressed in
integer, decimal, or rational formats. In all cases, numbers are
understood by Gambit to be exact, and represented as such internally.
For example, the numerical entries 0.1 and 1/10 represent the same
quantity.

In versions 0.97 and prior, Gambit distinguished between floating
point and rational data. In these versions, the quantity 0.1 was
represented interally as a floating-point number. In this case, since
0.1 does not have an exact representation in binary floating point,
the values 0.1 and 1/10 were not identical, and some methods for
computing equilibria could give (slightly) different results for games
using one versus the other. In particular, using rational-precision
methods on games with the floating point numbers could give unexpected
output, since the conversion of 0.1 first to floating-point then to
rational would involve roundoff error. This is largely of technical
concern, and the current Gambit implementation now behaves in such a
way as to give the “expected” result when decimal numbers appear in
the file format.



The extensive game (.efg) file format

The extensive game (.efg) file format has been used by Gambit, with
minor variations, to represent extensive games since circa 1994. It
replaced an earlier format, which had no particular name but which had
the conventional extension .dt1. It is intended that some new formats
will be introduced in the future; however, this format will be
supported by Gambit, possibly through the use of converter programs to
those putative future formats, for the foreseeable future.


A sample file

This is a sample file illustrating the general format of the file.
This file is similar to the one distributed in the Gambit distribution
under the name bayes1a.efg .

EFG 2 R "General Bayes game, one stage" { "Player 1" "Player 2" }
c "ROOT" 1 "(0,1)" { "1G" 0.500000 "1B" 0.500000 } 0
c "" 2 "(0,2)" { "2g" 0.500000 "2b" 0.500000 } 0
p "" 1 1 "(1,1)" { "H" "L" } 0
p "" 2 1 "(2,1)" { "h" "l" } 0
t "" 1 "Outcome 1" { 10.000000 2.000000 }
t "" 2 "Outcome 2" { 0.000000 10.000000 }
p "" 2 1 "(2,1)" { "h" "l" } 0
t "" 3 "Outcome 3" { 2.000000 4.000000 }
t "" 4 "Outcome 4" { 4.000000 0.000000 }
p "" 1 1 "(1,1)" { "H" "L" } 0
p "" 2 2 "(2,2)" { "h" "l" } 0
t "" 5 "Outcome 5" { 10.000000 2.000000 }
t "" 6 "Outcome 6" { 0.000000 10.000000 }
p "" 2 2 "(2,2)" { "h" "l" } 0
t "" 7 "Outcome 7" { 2.000000 4.000000 }
t "" 8 "Outcome 8" { 4.000000 0.000000 }
c "" 3 "(0,3)" { "2g" 0.500000 "2b" 0.500000 } 0
p "" 1 2 "(1,2)" { "H" "L" } 0
p "" 2 1 "(2,1)" { "h" "l" } 0
t "" 9 "Outcome 9" { 4.000000 2.000000 }
t "" 10 "Outcome 10" { 2.000000 10.000000 }
p "" 2 1 "(2,1)" { "h" "l" } 0
t "" 11 "Outcome 11" { 0.000000 4.000000 }
t "" 12 "Outcome 12" { 10.000000 2.000000 }
p "" 1 2 "(1,2)" { "H" "L" } 0
p "" 2 2 "(2,2)" { "h" "l" } 0
t "" 13 "Outcome 13" { 4.000000 2.000000 }
t "" 14 "Outcome 14" { 2.000000 10.000000 }
p "" 2 2 "(2,2)" { "h" "l" } 0
t "" 15 "Outcome 15" { 0.000000 4.000000 }
t "" 16 "Outcome 16" { 10.000000 0.000000 }







Structure of the prologue

The extensive gamefile consists of two parts: the prologue, or header,
and the list of nodes, or body. In the example file, the prologue is
the first line. (Again, this is just a consequence of the formatting
we have chosen and is not a requirement of the file structure itself.)

The prologue is constructed as follows. The file begins with the token
EFG , identifying it as an extensive gamefile. Next is the digit 2 ;
this digit is a version number. Since only version 2 files have been
supported for more than a decade, all files have a 2 in this position.
Next comes the letter R . The letter R used to distinguish files which
had rational numbers for numerical data; this distinction is obsolete,
so all new files should have R in this position.

The prologue continues with the title of the game. Following the title
is a list of the names of the players defined in the game. This list
follows the convention found elsewhere in the file of being surrounded
by curly braces and delimited by whitespace (but not commas,
semicolons, or any other character). The order of the players is
significant; the first entry in the list will be numbered as player 1,
the second entry as player 2, and so forth.  At the end of the prologue
is an optional text comment field.



Structure of the body (list of nodes)

The body of the file lists the nodes which comprise the game tree.
These nodes are listed in the prefix traversal of the tree. The prefix
traversal for a subtree is defined as being the root node of the
subtree, followed by the prefix traversal of the subtree rooted by
each child, in order from first to last. Thus, for the whole tree, the
root node appears first, followed by the prefix traversals of its
child subtrees. For convenience, the game above follows the convention
of one line per node.

Each node entry begins with an unquoted character indicating the type
of the node. There are three node types:


	c for a chance node


	p for a personal player node


	t for a terminal node




Each node type will be discussed individually below. There are three
numbering conventions which are used to identify the information
structure of the tree. Wherever a player number is called for, the
integer specified corresponds to the index of the player in the player
list from the prologue. The first player in the list is numbered 1,
the second 2, and so on. Information sets are identified by an
arbitrary positive integer which is unique within the player. Gambit
generates these numbers as 1, 2, etc. as they appear first in the
file, but there are no requirements other than uniqueness. The same
integer may be used to specify information sets for different players;
this is not ambiguous since the player number appears as well.
Finally, outcomes are also arbitrarily numbered in the file format in
the same way in which information sets are, except for the special
number 0 which indicates the null outcome.

Information sets and outcomes may (and frequently will) appear
multiple times within a game. By convention, the second and subsequent
times an information set or outcome appears, the file may omit the
descriptive information for that information set or outcome.
Alternatively, the file may specify the descriptive information again;
however, it must precisely match the original declaration of the
information set or outcome. If any part of the description is omitted,
the whole description must be omitted.

Outcomes may appear at nonterminal nodes. In these cases, payoffs are
interepreted as incremental payoffs; the payoff to a player for a
given path through the tree is interpreted as the sum of the payoffs
at the outcomes encountered on that path (including at the terminal
node). This is ideal for the representation of games with well-
defined”stages”; see, for example, the file bayes2a.efg in the Gambit
distribution for a two-stage example of the Bayesian game represented
previously.

In the following lists, fields which are omittable according to the
above rules are indicated by the label (optional).

Format of chance (nature) nodes. Entries for chance nodes begin
with the character c . Following this, in order, are


	a text string, giving the name of the node


	a positive integer specifying the information set number


	(optional) the name of the information set


	(optional) a list of actions at the information set with their
corresponding probabilities


	a nonnegative integer specifying the outcome


	(optional)the payoffs to each player for the outcome




Format of personal (player) nodes. Entries for personal player
decision nodes begin with the character p . Following this, in order,
are:


	a text string, giving the name of the node


	a positive integer specifying the player who owns the node


	a positive integer specifying the information set


	(optional) the name of the information set


	(optional) a list of action names for the information set


	a nonnegative integer specifying the outcome


	(optional) the name of the outcome


	the payoffs to each player for the outcome




Format of terminal nodes. Entries for terminal nodes begin with
the character t . Following this, in order, are:


	a text string, giving the name of the node


	a nonnegative integer specifying the outcome


	(optional) the name of the outcome


	the payoffs to each player for the outcome




There is no explicit end-of-file delimiter for the file.




The strategic game (.nfg) file format, payoff version

This file format defines a strategic N-player game. In this version,
the payoffs are listed in a tabular format. See the next section for a
version of this format in which outcomes can be used to identify an
equivalence among multiple strategy profiles.


A sample file

This is a sample file illustrating the general format of the file.
This file is distributed in the Gambit distribution under the name
e02.nfg .

NFG 1 R "Selten (IJGT, 75), Figure 2, normal form"
{ "Player 1" "Player 2" } { 3 2 }

1 1 0 2 0 2 1 1 0 3 2 0







Structure of the prologue

The prologue is constructed as follows. The file begins with the token
NFG , identifying it as a strategic gamefile. Next is the digit 1 ;
this digit is a version number. Since only version 1 files have been
supported for more than a decade, all files have a 1 in this position.
Next comes the letter R . The letter R used to distinguish files which
had rational numbers for numerical data; this distinction is obsolete,
so all new files should have R in this position.

The prologue continues with the title of the game. Following the title
is a list of the names of the players defined in the game. This list
follows the convention found elsewhere in the file of being surrounded
by curly braces and delimited by whitespace (but not commas,
semicolons, or any other character). The order of the players is
significant; the first entry in the list will be numbered as player 1,
the second entry as player 2, and so forth.

Following the list of players is a list of positive integers. This
list specifies the number of strategies available to each player,
given in the same order as the players are listed in the list of
players.

The prologue concludes with an optional text comment field.



Structure of the body (list of payoffs)

The body of the format lists the payoffs in the game. This is a “flat”
list, not surrounded by braces or other punctuation.

The assignment of the numeric data in this list to the entries in the
strategic game table proceeds as follows. The list begins with the
strategy profile in which each player plays their first strategy. The
payoffs to all players in this contingency are listed in the same
order as the players are given in the prologus. This, in the example
file, the first two payoff entries are 1 1 , which means, when both
players play their first strategy, player 1 receives a payoff of 1,
and player 2 receives a payoff of 1.

Next, the strategy of the first player is incremented. Thus, player
1’s strategy is incremented to his second strategy. In this case, when
player 1 plays his second strategy and player 2 his first strategy,
the payoffs are 0 2 : a payoff of 0 to player 1 and a payoff of 2 to
player 2.

Now the strategy of the first player is again incremented. Thus, the
first player is playing his third strategy, and the second player his
first strategy; the payoffs are again 0 2 .

Now, the strategy of the first player is incremented yet again. But,
the first player was already playing strategy number 3 of 3. Thus, his
strategy now “rolls over” to 1, and the strategy of the second player
increments to 2. Then, the next entries 1 1 correspond to the payoffs
of player 1 and player 2, respectively, in the case where player 1
plays his second strategy, and player 2 his first strategy.

In general, the ordering of contingencies is done in the same way that
we count: incrementing the least-significant digit place in the number
first, and then incrementing more significant digit places in the
number as the lower ones “roll over.” The only differences are that
the counting starts with the digit 1, instead of 0, and that the
“base” used for each digit is not 10, but instead is the number of
strategies that player has in the game.




The strategic game (.nfg) file format, outcome version

This file format defines a strategic N-player game. In this version,
the payoffs are defined by means of outcomes, which may appear more
than one place in the game table. This may give a more compact means
of representing a game where many different strategy combinations map
to the same consequences for the players. For a version of this format
in which payoffs are listed explicitly, without identification by
outcomes, see the previous section.


A sample file

This is a sample file illustrating the general format of the file.
This file defines the same game as the example in the previous
section.

NFG 1 R "Selten (IJGT, 75), Figure 2, normal form" { "Player 1" "Player 2" }

{
{ "1" "2" "3" }
{ "1" "2" }
}

{
{ "" 1, 1 }
{ "" 0, 2 }
{ "" 0, 2 }
{ "" 1, 1 }
{ "" 0, 3 }
{ "" 2, 0 }
}
1 2 3 4 5 6







Structure of the prologue

The prologue is constructed as follows. The file begins with the token
NFG , identifying it as a strategic gamefile. Next is the digit 1 ;
this digit is a version number. Since only version 1 files have been
supported for more than a decade, all files have a 1 in this position.
Next comes the letter R . The letter R used to distinguish files which
had rational numbers for numerical data; this distinction is obsolete,
so all new files should have R in this position.

The prologue continues with the title of the game. Following the title
is a list of the names of the players defined in the game. This list
follows the convention found elsewhere in the file of being surrounded
by curly braces and delimited by whitespace (but not commas,
semicolons, or any other character). The order of the players is
significant; the first entry in the list will be numbered as player 1,
the second entry as player 2, and so forth.

Following the list of players is a list of strategies. This is a
nested list; each player’s strategies are given as a list of text
labels, surrounded by curly braces.

The nested strategy list is followed by an optional text comment
field.

The prologue closes with a list of outcomes. This is also a nested
list. Each outcome is specified by a text string, followed by a list
of numerical payoffs, one for each player defined. The payoffs may
optionally be separated by commas, as in the example file. The
outcomes are implicitly numbered in the order they appear; the first
outcome is given the number 1, the second 2, and so forth.



Structure of the body (list of outcomes)

The body of the file is a list of outcome indices. These are presented
in the same lexicographic order as the payoffs in the payoff file
format; please see the documentation of that format for the
description of the ordering. For each entry in the table, a
nonnegative integer is given, corresponding to the outcome number
assigned as described in the prologue section. The special outcome
number 0 is reserved for the “null” outcome, which is defined as a
payoff of zero to all players. The number of entries in this list,
then, should be the same as the product of the number of strategies
for all players in the game.




The action graph game (.agg) file format

Action graph games (AGGs) are a compact representation of simultaneous-move games with structured utility functions.
For more information on AGGs, the following paper gives a comprehensive discussion.


A.X. Jiang, K. Leyton-Brown and N. Bhat, Action-Graph Games [http://www.cs.ubc.ca/~jiang/papers/AGG.pdf], Games and Economic Behavior, Volume 71, Issue 1, January 2011, Pages 141-173.




Each file in this format describes an action graph game.
In order for the file to be recognized as AGG by GAMBIT, the initial line of the file should be:

#AGG





The rest of the file consists of 8 sections, separated by whitespaces. Lines with starting ‘#’ are treated as comments and are allowed between sections.


	The number of players, n.


	The number of action nodes, |S|.


	The number of function nodes, |P|.


	Size of action set for each player. This is a row of n integers:

|S1| |S2| …. |Sn|



	Each Player’s action set. We have N rows; row i has |Si| integers in ascending order,
which are indices of Action nodes. Action nodes are indexed from 0 to |S|-1.


	The Action Graph. We have |S|+|P| nodes, indexed from 0 to |S|+|P|-1.
The function nodes are indexed after the action nodes. The graph
is represented as (|S|+|P|) neighbor lists, one list per row.
Rows 0 to |S|-1 are for action nodes; rows |S| to |S|+|P|-1 are for
function nodes. In each row, the first number |v| specifies the
number of neighbors of the node. Then follows |v| numbers,
corresponding to the indices of the neighbors.

We require that each function node has at least one neighbor, and
the neighbors of function nodes are action nodes. The action graph
restricted to the function nodes has to be a directed acyclic graph (DAG).



	Signatures of functions.   This is |P| rows, each specifying the mapping
f_p that maps from the configuration of the function node p’s neighbors to
an integer for p’s “action count”. Each function is specified by its “signature”
consisting of an integer type, possibly followed by further parameters. Several types of mapping are
implemented:


	Types 0-3 require no further input.



	Type 0: Sum. i.e. The action count of a function node p is the sum of
the action counts  of p’s neighbors.


	Type 1: Existence: boolean for whether the sum of the counts of
neighbors are positive.


	Type 2: The index of the neighbor with the highest index that has
non-zero counts, or |S|+|P| if none applies.


	Type 3: The index of the neighbor with the lowest index that has
non-zero counts, or |S|+|P| if none applies.









	Types 10-13 are extended versions of type 0-3, each requiring
further parameters of an integer default value and a list of weights,
|S| integers enclosed in square brackets. Each action node is thus associated with an integer weight.



	Type 10: Extended Sum. Each instance of an action in p’s neighborhood being chosen contributes the
weight of that action to the sum. These are added to the default value.


	Type 11: Extended Existence: boolean for whether the extended sum is positive. The input default value
and weights are required to be nonnegative.


	Type 12: The weight of the neighbor with the highest index that has
non-zero counts, or the default value if none applies.


	Type 13: The weight of the neighbor with the lowest index that has
non-zero counts, or the default value if none applies.











The following is an example of the signatures for an AGG with three action nodes and two function nodes:

2
10 0 [2 3 4]







	The payoff function for each action node. So we have
|S| subblocks of numbers. Payoff function for action s is a mapping
from configurations to real numbers. Configurations are
represented as a tuple of integers; the size of the tuple is the size
of the neighborhood of s. Each configuration specifies the action counts
for the neighbors of s, in the same order as the neighbor list of s.

The first number of each subblock specifies
the type of the payoff function. There are multiple ways of representing
payoff functions; we (or other people) can extend the file format by
defining new types of payoff functions. We define two basic types:


	Type 0

	The complete representation. The set of possible
configurations can be derived from the action graph. This set of
configurations can also be sorted in lexicographical order. So we can
just specify the payoffs without explicitly giving the configurations.
So we just need to give one row of real numbers, which correspond to
payoffs for the ordered set of configurations.

If action s is in multiple players’ action sets (say players
i, j),
then it is possible that the set of possible configurations
given si
is different from the set of possible configurations given
sj.
In such cases, we need to specify payoffs for the union of the
sets of configurations (sorted in lexicographical order).



	Type 1

	The mapping representation, in which we specify the configurations
and the corresponding payoffs. For the payoff function of action s,
first give Delta_s, the number of elements in the mapping.
Then follows Delta_s rows. In each row, first specify the configuration,
which is a tuple of integers, enclosed by a pair of brackets “[” and “]”,  then the payoff.
For example, the following specifies a payoff function of type 1, with two configurations:

1 2
[1 0] 2.5
[1 1] -1.2















The Bayesian action graph game (.bagg) format

Bayesian action graph games (BAGGs) are a compact representation of Bayesian (i.e., incomplete-information) games.
For more information on BAGGs, the following paper gives a detailed discussion.


A.X. Jiang and K. Leyton-Brown, Bayesian Action-Graph Games [http://www.cs.ubc.ca/~jiang/papers/BAGG.pdf]. NIPS, 2010.




Each file in this format describes a BAGG.
In order for the file to be recognized as BAGG by GAMBIT, the initial line of the file should be:

#BAGG





The rest of the file consists of the following sections,
separated by whitespaces. Lines with starting ‘#’ are treated as comments and are allowed between sections.


	The number of Players, n.


	The number of action nodes, |S|.


	The number of function nodes, |P|.


	The number of types for each player, as a row of n integers.


	Type distribution for each player. The distributions are assumed to be independent.
Each distribution is represented as a row of real numbers.
The following example block gives the type distributions for a BAGG with two players and two types for each player:

0.5 0.5
0.2 0.8







	Size of type-action set for each player’s each type.


	Type-action set for each player’s each type.
Each type-action set is represented as a row of integers in ascending order,
which are indices of action nodes. Action nodes are indexed from 0 to |S|-1.


	The action graph: same as in the AGG format.


	types of functions: same as in the AGG format.


	utility function for each action node: same as in the AGG format.
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